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PREFACE
About This Manual
This manual describes how to install and operate the MK-21/ISA Bathythermograph Data
Acquisition System along with how to install and operate the WinMK21 Data Acquisition
and Post-Processing Software on a PC to acquire, process, view, analyze, and archive data
from expendable oceanographic instruments. It is provided for informational and
reference purposes only and is as accurate as reasonably possible. It is also subject to
change without notice.

This manual is divided into the following six sections:

Section 1: System Overview.  Provides a general overview of the MK-21/ISA
Bathythermograph Data Acquisition System, the WinMK21 Data Acquisition and
Post-Processing Software, and Sippican’s expendable oceanographic probes.

Section 2: Installing the MK21 Interface Board and WinMK21.  Provides detailed
instructions on how to install a MK21 interface board in your computer, how to install
WinMK21 and the MK-21 ISA driver, and how to start and exit from WinMK21. In
addition, a procedure is provided for verifying proper operation of the MK21 interface
board.

Section 3: Installation and Test.  Provides instructions on how to set up your
computer and connect it to an isolated power source, and how to unpack, mount and
ground an LM-2A, LM-3A or LM-4A launcher and connect it to the MK21 interface
board in the computer. In addition, procedures are included for verifying operation of the
system before launching a probe.

Section 4: Operation.  Describes how to operate the WinMK21 Data Acquisition and
Post-Processing Software to launch an expendable probe and acquire and process the data
from it.

Section 5: WinMK21 Windows and Commands.  Includes the same information
provided by the WinMK21 Software Reference component of the online Help.

Section 6: Serial-Binary Data Transmission Description.  Specifies the interface
requirements for WinMK21 and an external serial device to achieve the serial-binary data
transmission between them.
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Minimum System Computer Requirements
The recommended minimum system computer requirements for WinMK21 to operate
efficiently include the following:

• Microsoft Windows NT/2000/XP

• Pentium III 700 Mhz processor

• 64 MB of RAM

• 200 MB of available hard drive space

• VGA monitor with 1024 x 768 of resolution

• Available ISA slot

• Mouse

• RS-232 serial port for navigation input and/or data transmission 

• Parallel printer port

Notes, Warnings and Cautions
Where applicable, notes, warnings and cautions are provided as follows:

NOTE  Provides you with recommendations or general information that is
supplemental to the information provided. 

WARNING  Alerts you to the possibility of injury or death to yourself or to
others.

CAUTION  Alerts you to the possibility of damage to equipment or to data.
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Safety Precautions
The general safety precautions listed below apply to the overall operation, installation and
maintenance of the MK-21/ISA. All operators should observe these precautions when
operating or servicing it.

Never do the following:

NEVER  remove or replace the MK21 interface board with the computer turned on or
with the AC power cable plugged into a power outlet.

NEVER  service or adjust the MK-21/ISA alone.

NEVER  allow the MK21 interface board to get wet.

NEVER  attempt to force the MK21 interface board into the ISA connector of the
computer as it could damage either the board or the connector socket.

NEVER  touch the contact pins of the MK21 interface board as the board is
electrostatic discharge (ESD) sensitive.

How to Contact Sippican, Inc.
Sippican welcomes your comments. Please contact Ocean Support at Sippican to offer any
comments or suggestions about this manual or to request technical support. Ocean Support
can be contacted using any of the following means:

Mail
Ocean Support
Sippican, Inc.
Sea-Air Systems Division
Seven Barnabas Road
Marion, MA  02738

Email
oceansupport@sippican.com

Telephone
(508) 748-1160

Facsimile
(508) 748-3626

For more information about Sippican and our products, visit our Web site at
www.sippican.com.
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SECTION 1
SYSTEM OVERVIEW

he MK-21/ISA Bathythermograph Data Acquisition System is a portable data
acquisition system that measures and outputs ocean temperature, conductivity and
sound velocity versus depth using expendable probes that are launched from

surface ships. The measurements can be displayed on a PC that has a MK21 interface
board installed and is running the WinMK21 Data Acquisition and Post-Processing
Software. WinMK21 provides a convenient, user friendly means of displaying the data in
real time and recording the data on disk for later analysis. Any person having general
knowledge of basic PC operating systems can operate WinMK21, which is included on a
CD with the MK21 interface board.

This section provides a general overview of the MK-21/ISA Bathythermograph Data
Acquisition System, including brief descriptions of the following: 

• MK21 interface board connectors

• WinMK21 Data Acquisition and Post-Processing Software

• XBT, XSV and XCTD expendable probes

• Test canisters

• LM-2A, LM-3A and LM-4A launchers

The MK21 interface board, when installed in an available ISA slot of the PC, inputs and
processes the data from Sippican XBT, XSV and XCTD probes launched from Sippican
LM-2A, LM-3A and LM-4A launchers. And with the WinMK21 Data Acquisition and
Post-Processing Software installed on the computer, profiles of temperature verses depth,
sound velocity verses depth, and temperature and conductivity verses depth can be
displayed, stored on disk, output on a serial port of the computer, and printed. The MK-21/
ISA Bathythermograph Data Acquisition System, along with the available launchers, is
illustrated in Figure 1-1.

An optionally supplied connector box is available with the MK-21/ISA. The connector
box provides an alternate ground connection for the installed launcher and is prewired
with an interface cable that connects to the MK21 interface board. A watertight junction
box may be used instead of the connector box.

T
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1.1 MK21 Interface Board and Connector Box
Specifications

The general specifications for the MK21 interface board (p/n 305935-1) are the following:

Interface connection: ISA

Computer operating system
requirements: Windows NT/2000/XP

Operating temperature range: 0°C to 40°C (32°F to 104°F)

Storage temperature range: -10°C to 65°C (14°F to 149°F)

Relative humidity: 0–90% noncondensing

AUDIO connector: BNC

CONNECTOR BOX connector: DB-9S

FIGURE 1-1:  The MK-21/ISA Bathythermograph Data Acquisition System 
with the Available Launchers
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The connector box is available in two configurations: with a 3.0-meter prewired interface
cable (P/N 306146-1) and with a 6.1-meter prewired interface cable (P/N 306146-2). The
connector box also includes a binding post for grounding and a 4-postion terminal strip for
making the launcher connection to the MK21 interface board.

The general specifications for the connector box are the following:

Size: 5.5 in. long by 4.0 in. wide by 2.5 in. high

Weight: 1 lb, 1 oz (0.48 kg), with 3.0-meter interface cable

Interface cable connector: DB-9P

1.2 MK21 Interface Board Connectors
The MK21 interface board provides the following two connectors on the expansion card
bracket:

AUDIO IN: Connects to the output of a Sippican MK-10A
Data Acquisition System for air-launched probes.
A mating BNC connector and cable are required.

CONNECTOR BOX: Connects to an optionally supplied connector box
(P/N 306146-1 or P/N 306146-2) or to a junction
box, either of which is wired to a LM-2A, LM-3A
or LM-4A launcher. A DB-9P mating connector
and cable are required and are supplied with the
connector box.

1.3 WinMK21 Data Acquisition and Post-Processing
Software

The MK-21/ISA Bathythermograph Data Acquisition System includes the WinMK21
Data Acquisition and Post-processing Software on a CD for installation on a desktop PC.
The CD also includes MK-21 ISA drivers for installation on a computer running Windows
NT/2000/XP. You must install a MK-21 ISA driver so your computer can interface with
the MK21 interface board.

Through the ISA connection to the MK21 interface board, WinMK21 controls the MK21
interface board and all of its data acquisition functions. In addition, WinMK21 inputs the
data from the MK21 interface board, provides real-time display and post-processing of the
data, stores the data on disk, and can output the data on a serial port of the computer, and
print the data. With WinMK21 running on the computer, WinMK21 is ready to acquire
new data.
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1.3.1 Graphics and Launch Information Displays 
After launching a probe, it descends through the water and collects measurements in real
time. The data can be viewed in real time as profiles in the Graphics display in the Main
window as shown in Figure 1-2, which displays the temperature and conductivity verses

depth profiles acquired by an XCTD probe. In addition, the Launch Information display
provides critical information about the drop. All of the measured data and all of the launch
information are automatically recorded on the hard drive at the end of the drop for later
use with spreadsheets and other analytical tools.

FIGURE 1-2:  Graphics and Launch Information Displays in the Main Window 
at the End of an XCTD Probe Drop

Temperature profile

Conductivity profile

Graphics display

Launch 
Information 
display
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1.3.2 Operating Modes
WinMK21 operates in two modes: Data Acquisition and Post Processing. In Data
Acquisition mode, "Realtime Data Acquisition" is displayed in the Title bar of the Main
window. In Post-Processing mode, the name of the open file is displayed.

Data Acquisition mode encompasses the loading of a probe into its launcher, the
launching of a probe and the acquiring of data throughout its descent. In Data Acquisition
mode WinMK21 detects when a probe is loaded and, after launching the probe, it detects
when it enters the water. During the descent the data are displayed in the Graphics display
as shown in Figure 1-2 and recorded on the hard drive. The data can also be output on a
serial port. At the end of the probe drop, WinMK21 automatically switches to Post
Processing mode. No operator intervention is required during the entire descent.

Post-Processing mode allows you to display the stored profiles of previous probe drops,
and it allows you to perform various data analysis, presentation and export operations.

1.4 Expendable Probes
Sippican expendable probes are small oceanographic sensors that are housed in tubular
protective canisters. There are three types of probes that are available for use with the
MK-21/ISA: an XBT probe, which measures water temperature; an XSV probe, which
measures sound velocity in the water; and an XCTD probe, which measures both water
temperature and conductivity. The probes free-fall in the ocean at a known rate while
collecting the data.

To launch a probe from a vessel, the canister containing the probe is first inserted into one
of the Sippican launchers—an LM-2A Deck-Mounted Launcher, an LM-3A Hand-Held
Launcher, or an LM-4A Thru-Hull Launcher. Contacts on the canister provide the
electrical connections to the launcher which is connected by cable to the MK21 interface
board. When the probe is ready to be launched, the operator pulls a release pin out of the
canister, and the probe slides out of the canister into the water. The probe's hydrodynamic
shape allows it to descend through the water at a stable and known rate, enabling
continuous calculation of its depth throughout the entire descent. As the probe descends,
its sensors continuously measure the water temperature, the sound velocity, or the
temperature and conductivity. The measurements are transmitted by a wire back to the
MK21 interface board. The wire dereels both from a spool in the probe as the probe
descends and from a spool in the canister as the vessel from which the probe was launched
moves along the surface. This dual spooling technique enables the wire to remain
stationary in the water. More than a mile of wire can be contained inside a probe less than
half a meter in length. Soon after the probe reaches it’s maximum depth, its wire breaks
and the probe continues its descent to the ocean floor.
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1.4.1 XBT Probe
The expendable bathythermograph (XBT) probe,
which is shown in Figure 1-3, measures water
temperature verses water depth. And in regions of
known and constant salinity, WinMK21 can calculate
and display sound velocity verses depth from the
temperature data acquired by an XBT probe. The
probe contains a temperature sensing thermistor
connected to a two-conductor insulated wire that is
wound on two spools, a spool inside the probe and a
spool inside the canister with the probe. The nose of
the probe is a seawater electrode which provides an
electrical ground path to the MK21 interface board and
enables the MK21 interface board to detect when the
probe enters the water.

There are several types of XBT probes. They vary in their maximum depths and the
maximum vessel speeds at which they can be launched. The available XBT probes and
their performance characteristics are listed in Table 1-1.

TABLE 1-1:  XBT Probe Types and Capabilities

TYPE APPLICATION MAXIMUM DEPTH MAXIMUM VESSEL 
SPEED

T-4 Standard Navy applications 1500 ft (460 m) 30 knots

T-5 Deep ocean scientific and military 6000 ft (1830 m) 6 knots

Fast 
Deep Enhanced depth and vessel speed 3280 ft (1000 m) 20 knots

T-6 Oceanography 1500 ft (460 m) 15 knots

T-7 Special military applications 2500 ft (760 m) 15 knots

Deep 
Blue Medium deep oceanography 2500 ft (760 m) 20 knots

T-10 Commercial fisheries 660 ft (200 m) 10 knots

T-11 (fine 
structure) Extra fine depth resolution 1500 ft (460 m) 6 knots

T-12 Fast ship launch speed, deep ocean 6560 ft (2000 m) 20 knots

FIGURE 1-3:  XBT Probe
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1.4.2 XSV Probe
The expendable sound velocity (XSV) probe, which is
shown in Figure 1-4, measures sound velocity in water
verses depth. Applications include antisubmarine
warfare (ASW), coastal mine countermeasures and
oceanographic research. It is particularly useful in
regions where salinity varies with depth, making
calculation of sound velocity from XBT data
impractical. The XSV uses an active electronic sensor
in the probe and a single-conductor insulated wire to
transmit sound velocity data to the MK21 interface
board. An internal battery provides power for the
probe’s electronics. Similar to the XBT, the XSV uses
two wire spools, one inside the probe and one inside
the canister with the probe.

The XSV measures the speed of sound in water using a piezoelectric transducer inside the
probe’s nose. The sensor is in the path of the flowing water as the probe descends and is
pulsed at 6.5 MHz, producing an acoustic signal. The signal travels a known distance and
is reflected back to the transducer. The reflected signal is detected which triggers another
6.5-MHz pulse. This cycle is repeated continuously, causing the transducer to
"sing-around" at a frequency from 27 kHz to 30 kHz, depending on the water temperature,
salinity and depth. The sing-around frequency, which is linearly proportional to sound
velocity, is counted down to a low audio range of 210 Hz to 233 Hz and transmitted to the
MK21 interface board, which converts the frequency into sound velocity.

There are three types of XSV probes. They vary in their maximum depths and the
maximum vessel speeds at which they can be launched. The available XSV probes and
their performance characteristics are listed in Table 1-2.

TABLE 1-2:  XSV Probe Types and Capabilities

TYPE APPLICATION MAXIMUM DEPTH MAXIMUM VESSEL 
SPEED

XSV-01 ASW and Oceanography 2790 ft (850 m) 15 knots

XSV-02 Deep ocean scientific and military 6560 ft (2000 m) 15 knots

XSV-03 Enhanced depth resolution 2790 ft (850 m) 5 knots

FIGURE 1-4:  XSV Probe
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1.4.3 XCTD Probe
The expendable conductivity/temperature (XCTD)
probe, which is shown in Figure 1-5, measures water
temperature and conductivity verses water depth. From
the XCTD data, WinMK21 can calculate and display
salinity, water density and sound velocity. The XCTD
uses a conductivity cell to measure water conductivity
and a high-stability, fast-response thermistor to
measure water temperature. An internal,
microprocessor-based circuit converts the sensor
outputs into digital signals that are transmitted to the
MK21 interface board over a two-conductor insulated
wire. An internal battery provides the required power.
Similar to the XBT, the XCTD uses two wire spools,
one inside the probe and one inside the canister with
the probe.

Each XCTD probe is calibrated against temperature and conductivity standards in a set of
saltwater baths. The calibration data for each probe are used to determine the unique
calibration coefficients for the probe’s conductivity cell and thermistor. The calibration
coefficients, along with the probe’s serial number, terminal depth and drop rate
coefficients, are permanently stored in a memory circuit in the probe. The memory is
automatically accessed by the MK21 interface board when the canister containing the
XCTD probe is loaded into a launcher. The coefficients are used during the probe’s
descent to accurately calculate the acquired conductivity and temperature data. The drop
rate coefficients are used to determine the water depth during the descent. WinMK21 also
stores the serial number with the temperature and conductivity data.

There are two types of XCTD probes. They are listed in Table 1-3.

TABLE 1-3:  XCTD Probe Types and Capabilities

TYPE APPLICATION MAXIMUM DEPTH MAXIMUM VESSEL 
SPEED

XCTD-1 Navy and oceanographic 3280 ft (1000 m) 10 knots

XCTD-2 Deep ocean scientific and military 6070 ft (1850 m) 3.5 knots

FIGURE 1-5:  XCTD Probe
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1.5 Test Canisters
The test canisters are self-contained, reusable probe simulators which are used to verify
the operation of the MK-21/ISA Bathythermograph Data Acquisition System. They
provide the operator with operational confirmation without expending actual probes.
Specifically, the test canisters verify the proper operation of the launcher, the cabling, the
MK21 interface board, and the WinMK21 Data Acquisition and Post-Processing
Software. Three test canisters are available: an XBT Test Canister, an XCTD-1 Test
Canister and an XCTD-2 Test Canister. The test canisters resemble the actual probe
canisters. The XBT Test Canister, however, is bright red.

The XBT Test Canister contains a precision resistor with the same resistance value as a
thermistor that is in 1.5°C (±0.1°C) water. The XCTD-1 and XCTD-2 Test Canisters
contain battery powered electronics which simulate a probe drop in water of about 15°C
and conductivity of about 40 mS/cm. For an XCTD-1 Test Canister, the electronics are
activated by a toggle switch on one end of the canister. For an XCTD-2 Test Canister, the
electronics are activated by a toggle switch and by pulling the release pin. An indicator
illuminates when the electronics is active.

The three test canisters are listed in Table 1-4. 

TABLE 1-4:  Test Canister Types

TEST CANISTER TYPE APPLICATION EXPECTED OUTPUT

XBT Test Canister

System verification and fault isolation

1.5°C (±0.1°C)

XCTD-1 Test Canister
Approximately 15°C 

and 40 mS/cmXCTD-2 Test Canister
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1.6 Launchers
Three types of Sippican launchers are available for surface ship applications: an LM-2A
Deck-Mounted Launcher, which is easily installed on the deck of any vessel; an LM-3A
Hand-Held Launcher, which is portable and allows you to easily position it such that it
does not interfere with other equipment; and an LM-4A Thru-Hull Launcher, which is the
standard launcher for all military vessels and is installed below deck for safety and
convenience when launching probes under heavy weather conditions.

1.6.1 LM-2A Deck-Mounted Launcher
The LM-2A Deck-Mounted Launcher is illustrated in Figure 1-6. It consists of a launch
tube, a breech, a breech adapter, a stanchion, and a 100-foot electrical cable for connection
to the MK21 interface board. The LM-2A is mounted so the launch tube protrudes beyond
the edge of the ship's deck. To load a probe the launch operator opens the breech, inserts
the canister containing the probe into the launcher, making sure the release pin is aligned
with the slot in the launcher, and then closes the breech. The connection to the three
contacts on the probe canister is made automatically by pins in the breech when the breech
is closed. To launch the probe the operator pulls the pin out of the canister, allowing the
probe to slide out of the launch tube and into the water. At the end of the probe drop, the
operator breaks the trailing wire free. The spent canister should be retained in the launcher
to protect the contacts until a new probe is loaded.

FIGURE 1-6:  The LM-2A Deck-Mounted Launcher
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1.6.2 LM-3A Hand-Held Launcher
The LM-3A Hand-Held Launcher is a lightweight, easy to use alternative to the LM-2A
Deck-Mounted Launcher. The LM-3A is illustrated in Figure 1-7. It consists of a body, a
yoke, a contact pin assembly, a contact lever, and a 50-foot electrical cable for connection
to the MK21 interface board. A longer cable can be supplied upon request. 

The LM-3A is intended for use on vessels where a permanent LM-2A Deck-Mounted
Launcher installation is impractical. To load a probe, the launch operator first raises the
contact lever to extend the yoke forward, then lays the canister containing the probe into
the cradle such that the end cap of the canister fits into the yoke end of the launcher and
the loop of the release pin is positioned in the release pin slot. Next, the operator swings
the contact lever down, pulling the yoke and canister toward the rear of the launcher. The
contact pins penetrate the insulation on the back of the canister, making a reliable
electrical connection with the canister contacts. To launch the probe, the operator holds
the launcher over the edge of the deck and pulls the release pin out of the canister,
allowing the probe to slide out of the canister and into the water. The operator must hold
the launcher and canister far enough over the edge of the deck to ensure the wire does not
come in contact with any part of the ship for the duration of the probe’s descent. At the
end of the probe drop, the operator breaks the trailing wire free. The spent canister should
be retained in the launcher to protect the contacts until a new probe is loaded.

FIGURE 1-7:  The LM-3A Hand-Held Launcher
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1.6.3 LM-4A Hull-Mounted Launcher
The LM-4A Hull-Mounted Launcher is intended for permanent installation on ocean
going vessels. The LM-4A is illustrated in Figure 1-8. It provides the launch operator
complete isolation from the weather. If the LM-4A is installed near the computer, a single
operator can handle all launcher and MK-21/ISA tasks. The LM-4A includes a 100-ft
electrical cable for connection to the MK21 interface board.

The LM-4A consists of a breech and a breech adapter that are essentially the same as on
the LM-2A Deck-Mounted Launcher. The launch tube, which penetrates the hull, is made
of urethane and is mounted on a ship's adapter and a manually operated ball valve. The
adapter, which is welded to the interior plating of the ship's hull, provides a rigid mount
for the entire assembly. To load a probe the launch operator first opens the ball valve, then
the breech, and inserts the canister containing the probe into the launcher, making sure the
release pin is aligned with the slot in the launcher. The operator then closes the breech.
The connection to the three contacts on the probe canister is made automatically by pins in
the breech when the breech is closed. To launch the probe the operator pulls the pin out of
the canister, allowing the probe to slide out of the launch tube and into the water. At the
end of the probe drop, the operator opens the breech, removes the spent canister, breaks
the trailing wire free, letting it fall through the launch tube, and then closes the breech and
ball valve. It is essential to make sure the ball valve is clear of wire before it is closed.
Closing the valve with wire present is likely to damage the valve. The breech and ball
valve should remain closed at all times except during the launch and descent of a probe.

FIGURE 1-8:  The LM-4A Hull-Mounted Launcher



2-1

MK-21/ISA  Bathythermograph Data Acquisition System

SECTION 2
INSTALLING THE MK21 INTERFACE BOARD

AND WINMK21

his section provides detailed instructions on how to install a MK21 interface
board in your computer, how to install WinMK21 and the MK-21 ISA driver, and
how to start and exit from WinMK21. In addition, a procedure is provided for

verifying proper operation of the MK21 interface board. 

2.1 Unpacking and Installing the MK21
Interface Board

Unpack the MK21 interface board and inspect it for damage. Report any damage to
Sippican. Do not install the MK21 interface board in your computer if it appears damaged.

To install the MK21 interface board:

1. Discharge any static electricity from your body by touching a grounded metal 
surface, such as an exposed metal surface of your computer.

2. Turn off the computer and disconnect the power cord

3. Open the computer case. Refer to your computer manual for instructions if required.

4. Locate an unused ISA expansion slot. Refer to your computer manual if you need 
help in locating one.

5. Remove the screw securing the expansion slot cover and remove the cover. Save the 
screw.

6. Insert the MK21 interface board into the slot and seat it firmly. Avoid touching the 
contact pins of the board. 

7. Secure the MK21 interface board to the rear panel with the screw that was removed 
earlier.

8. Close the computer case.

CAUTION  The MK21 interface board is electrostatic discharge (ESD)
sensitive. Follow ESD handling procedures when working with the MK21
interface board.

T
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2.2 Installing WinMK21
To install WinMK21:

1. Exit all programs and turn off any virus protection or screen saver software.

2. Insert the WinMK21 for Windows CD into your CD-ROM drive.

The installation program should start automatically and the Welcome dialog box 
should open:

If the installation program does not start automatically, select Start and then choose 
Run to open the Run dialog box. In the Run dialog box type d:setup, where "d" is the 
drive letter of your CD-ROM drive, and then click OK. The Welcome dialog box 
should open.

3. Click Next in the Welcome dialog box.

The License Agreement dialog box opens:

4. Select the I accept the terms in the license agreement option, and then click Next if 
you accept this Sippican, Inc. Software License Agreement.

The Destination Folder dialog box opens:
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5. Click Next to accept the recommended directory to install WinMK21. Or instead, if 
you want to install the program in a different directory, click Change, choose the 
directory, and then click Next.

The Setup Type dialog box opens:

6. Select the Custom option, and then click Next.

The Custom Setup dialog box opens:
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7. Select Win2000/XP driver, and then click the down arrow next to it.

A pop-up menu appears:

8. Click This feature will be installed on local hard drive.

The pop-up menu closes and the Custom Setup dialog box displays the hard drive 
icon for the Win2000/XP driver:

9. Click Next.

The Ready to Install the Program dialog box opens:
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10. Click Install to install WinMK21.

The WinMK21 program files are copied to the specified destination directory, and 
then the InstallShield Wizard Completed dialog box opens:

11. Click Finish.

WinMK21 finishes installing.

2.3 Installing the MK-21 ISA Driver on Your Computer
For your computer to communicate properly with the MK21 interface board, you must
install a MK-21 ISA driver. Drivers are provided for installation on a computer running
Windows NT/2000/XP. These drivers are automatically copied to the computer’s hard
drive when WinMK21 is installed.

After installing the MK-21 ISA driver, you should verify proper operation of the MK21
interface board. Instructions are provided below for installing the MK-21 ISA driver and
for verifying proper operation of the MK21 interface board.

2.3.1 Installing the MK-21 ISA Driver for Windows XP
To install the MK-21 ISA driver on a computer running Windows XP:

1. Remove the WinMK21 for Windows CD from your CD-ROM drive.

2. Start Windows XP.

3. Click Start, select Control Panel, and then choose Printers and Other Hardware.

4. Choose Add Hardware from the See Also menu.
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5. Click Next.

Windows attempts to locate the hardware device.

6. Click Next when the button is available.

7. Select the Yes, I have already connected the hardware option, and then click Next.
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8. Select Add a new hardware device, and then click Next.

9. Select the Install the hardware that I manually select from a list (Advanced) option, 
and then click Next.

10. Select Show All Devices, and then click Next.
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11. Click Have Disk.

12. Verify that C:\Program Files\Sippican\MK21WDM is displayed in the Copy 
manufacturer’s files from text box, and then click OK.

13. Select MK21 interface board, and then click Next.
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14. Click Next.

15. Click Finish. The MK-21 ISA driver for Windows XP finishes installing.

If you are required to change the port address of the MK21 interface board, continue 
with the steps below. Normally you should not have to change the port address.

16. Click Start, select Settings, and then choose Control Panel.

17. Choose System, and then click the Hardware tab in the System Properties dialog box.

18. Click Device Manager.
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19. Double click MK21 interface board devices, right click MK21 interface board, and 
then choose Properties from the pop-up menu.

20. Click the Resources tab.

21. Select a new configuration, such as Basic configuration 0000 in the Settings based 
on drop-down list box, and then select I/O Range in the Resource settings list.

22. Click Change Setting.
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23. Click the up or down arrow in the Value drop-down list box, select the required port 
address range, and then click OK.

The selected I/O Range should now be displayed in the Resource settings list.

24. Click OK.

2.3.2 Installing the MK-21 ISA Driver for Windows 2000
To install the MK-21 ISA driver on a computer running Windows 2000:

1. Remove the WinMK21 for Windows CD from your CD-ROM drive.

2. Start Windows 2000.

3. Click Start, select Settings, and then choose Control Panel.

4. Choose Add/Remove Hardware Wizard.

5. Click Next.
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6. Select the Add/Troubleshoot a device option, and then click Next.

Windows attempts to locate the hardware device.

7. Click Next when the button is available.

8. Select Add a new device, and then click Next.
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9. Select the No, I want to select the hardware from a list option, and then click Next.

10. Select Other devices, and then Next.

11. Click Have Disk.
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12. Click Browse, then select MK21WDM.INF from the C:\Program 
Files\Sippican\MK21WDM directory.

The Copy manufacturer’s files from text box should now display 
C:\sippican\winmk21\mk21wdm.

13. Click OK.

14. Select MK21 interface board, and then click Next.

15. Click Next.
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16. Click Finish. The MK-21 ISA driver for Windows 2000 finishes installing.

If you are required to change the port address of the MK21 interface board, continue 
with the steps below. Normally you should not have to change the port address.

17. Click Start, select Settings, and then choose Control Panel.

18. Choose System, and then click the Device Manager tab in the System Properties 
dialog box.

19. Double click MK21 interface board devices, right click MK21 interface board, and 
then choose Properties from the pop-up menu.
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20. Click the Resources tab.

21. Select a new configuration, such as Basic configuration 0000 in the Settings based 
on drop-down list box, and then select Input/Output Range in the Resource settings 
list.

22. Click Change Setting.
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23. Click the up or down arrow in the Value drop-down list box, select the required port 
address range, and then click OK.

The selected Input/Output Range should now be displayed in the Resource settings 
list.

24. Click OK.

2.4 Starting WinMK21
To start WinMK21:

1. Click Start, select Programs, and then choose Sippican - WinMK21.

2. From the Sippican - WinMK21 menu, choose WinMK21.

When you start WinMK21 for the first time, a Message dialog box opens. In the Message
dialog box, click Cancel if you do not want to locate the default backup on the A drive.
Otherwise click OK. If you click Cancel, a second Message dialog box opens indicating
the default backup path has been changed. To accept the changed path, click OK. For more
information about the backup option, see “System Parameters” on page 5-12. 

WinMK21 will also ask you for a password when you start it for the first time. Either enter
a password or click Cancel. If you enter a password, you will be asked to enter it if you
attempt to access restricted features such as the System Parameters. If you click Cancel,
you will not require a password. For more information about the password option, see
“Password Protection” on page 5-48.

2.5 Exiting from WinMK21
To exit from WinMK21 choose Exit from the File menu.
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2.6 Verifying Proper Operation of the
MK21 Interface Board

After you have installed the MK-21 ISA driver on your computer, you should verify
proper operation of the MK21 interface board.

To verify proper operation of the MK21 interface board:

1. Start WinMK21.

2. Verify that "MK21 Standby" is displayed in the Status bar at the bottom of the 
window.

3. Select MK21 I/O Board from the Actions menu, and then choose Initiate.

The MK21 interface board is initialized. This process takes about seven seconds 
during which the messages "Detect MK21" and "Test MK21" are displayed. If proper 
operation is established, no additional messages are displayed.

4. Verify that "MK21 Ready" is displayed in the Status bar at the bottom of the window. 

5. Exit from WinMK21.

If the MK21 interface board should fail to be detected, the port address of the board may
be in conflict with another hardware device in the computer. Refer to “MK21 Interface
Board Port Address” on page 5-54 for instructions on how to change the port address.

Contact Sippican technical support if the MK21 interface board repeatedly fails.
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SECTION 3
INSTALLATION AND TEST

his section provides instructions on how to set up your computer and connect it
to an isolated power source, and how to unpack, mount and ground an LM-2A,
LM-3A or LM-4A launcher and connect it to the MK21 interface board in the

computer. In addition, procedures are included for verifying operation of the system
before launching a probe.

For instructions on how to install the MK21 interface board in your computer, install
WinMK21, and install the MK-21 ISA driver for Windows NT/2000/XP, see SECTION 2,
“Installing the MK21 Interface Board and WinMK21.”

3.1 Setting up and Connecting the Computer
Setting up and connecting the computer encompasses the following:

• Finding a location

• Connecting an isolated power source

• Connecting the launcher cable

3.1.1 Finding a Location for the Computer
Set up the computer near a 100–240 VAC, 50–60 Hz power outlet. It should be located in
an area that is protected from weather and spray, and where the temperatures are
consistently between 0°C and 40°C (32°F to 104°F). Ensure the computer is secure and
that there is room behind it for connecting the cables. In addition, ensure there is plenty of
air circulation around and on top of the computer.

3.1.2 Connecting an Isolated Power Source to the Computer
If the 100–240 VAC, 50–60 Hz power source contains large amounts of line noise that
might affect the performance of the MK-21/ISA, an isolation transformer should be
connected between the power source and the computer. A Topaz Ultra Isolator,
Model 91095-12 from EPE Technologies, Inc., Costa Mesa, California or an equivalent is
recommended. In addition, an isolation plug should be used on the computer side of the
isolation transformer as shown in Figure 3-1. The isolation plug ensures there is no third
wire ground connection between the ship’s ground and the computer, including
peripherals such as a printer.

T
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3.1.3 Connecting the Launcher Cable to the
MK21 Interface Board

The LM-2A Deck-Mounted Launcher and the LM-4A Thru-Hull Launcher are supplied
with 100 feet of 3/8-inch outer diameter, insulated, shielded, five-conductor cable; the
LM-3A Hand-Held Launcher, 50 feet. Other lengths are available.

A connector box—available from Sippican and shown in Figure 3-2—or a similar
watertight junction box must be installed between the MK21 interface board and the
launcher. The connector box is prewired with an interface cable that connects to the MK21
interface board. For the connector box specifications and part numbers, see “MK21
Interface Board and Connector Box Specifications” on page 1-2. Connector boxes are
available with a 3.0-meter or a 6.1-meter prewired interface cable. Mount the connector
box or junction box near the computer by fastening it to a secure surface.

To connect the launcher to the MK21 interface board when using a connector box, connect
the interface cable to the CONNECTOR BOX connector on the board, and after installing
the launcher, wire the launcher cable to the connector box as described below. Refer to
“MK21 Interface Board Connectors” on page 1-3 for the location of the CONNECTOR
BOX connector. 

To connect the launcher to the MK21 interface board when using a watertight junction
box, wire the junction box to the board as described below, and after installing the
launcher, wire the launcher cable to the junction box.

FIGURE 3-1:  Connecting the Isolation Transformer to the Computer

NOTE  The maximum launcher cable length is 600 feet, and splices should be
in watertight junction boxes only.
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A seawater ground connection should be made at the connector box only if an adequate
ground is not possible at the launcher, or if an LM-3A Hand-Held Launcher will be used,
which requires that the ground connection be made at the connector box. To make the
ground connection, connect a 12 AWG wire to the ground post on the outside of the
connector box and to a good seawater ground, such as the ship’s plumbing. Connect the
ground post to the signal ground terminal as shown in Figure 3-2. If a junction box is used
instead of a connector box, it should be grounded in a similar manner.

To wire a junction box to the MK21 interface board, connect the junction box to the
CONNECTOR BOX connector on the back of the MK21 interface board using a mating
DB-9P connector and a 24 AWG, 4-conductor, shielded cable. The CONNECTOR BOX
connector is a DB-9S. Do not use a cable length longer than 30 feet. Wire the cable to the
mating connector in accordance with Table 3-1. Do not connect the shield to the connector
or to ground at any point, as doing so will create an undesired ground loop.

FIGURE 3-2:  Connector Box (Sippican P/N 306146-1) with Prewired Interface 
Cable

NOTE  If you make the seawater ground connection at the connector box, be
sure you do not attach the ground strap of the LM-2A Deck-Mounted Launcher
or the LM-4A Hull-Mounted Launcher to ground. Doing so will create an

undesired ground loop.
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To connect the launcher cable to the connector box:

1. Route the launcher cable from the launcher to the connector box.

If a junction box is used instead of a connector box, it should be watertight and the 
parallel leakage resistances should exceed 50 megohms. It should also have a sealing 
nut and strain relief assembly similar to that shown in Figure 3-2.

2. Remove the connector box cover.

3. Loosen the sealing nut from the strain relief assembly.

4. If the launcher cable has spade lugs, remove them.

5. Flush-cut the end of the launcher cable.

6. Strip off about two inches of the jacket and cut off the shield as it is not to be 
connected.

7. Strip approximately 1/2 inch of insulation off each wire.

8. Insert the launcher cable through the sealing nut and strain relief assembly, allowing 
enough length to make electrical connections.

9. Connect the stripped wires to the terminals on the terminal block as shown in 
Figure 3-2. The use of lugs is preferred to that of bare conductors. 

10. Tighten the sealing nut around the launcher cable and replace and secure the 
connector box cover.

TABLE 3-1:  Launcher Cable Connection Information

DB-9P MATING CONNECTOR 
PIN NUMBER

LAUNCHER CABLE 
WIRE COLOR FUNCTION

2 Red A Lead

6 Green B Lead

1 Black C Lead

3 White Signal Ground

— Braid Shield
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3.2 Unpacking and Installing the LM-2A
Deck-Mounted Launcher

Unpack the LM-2A Deck-Mounted Launcher and inspect it for damage. Report any
damage to Sippican. Do not install or operate the launcher if it appears damaged.

The LM-2A is intended for a semi-permanent installation by bolting it to an existing rail
post on the ship, or for a permanent installation by welding it to the deck of the ship. As
shown in Figure 3-3, the launcher should be mounted a minimum of six feet above the
water line of the ship, on the stern or on the port or starboard quarter, and so that the
launch tube protrudes beyond the edge of the deck. Avoid locations near garbage chutes or
other areas where solids are discharged, and areas where equipment could interfere with
the wire during launching.

Installation the LM-2A encompasses the following:

• Mounting 

• Grounding

• Routing the launcher cable

3.2.1 Mounting the LM-2A
The LM-2A Deck-Mounted Launcher includes a launcher assembly, a stanchion, an
accessory kit, and 100 feet of cable for connection to the MK21 interface board. The
launcher assembly is composed of a breech, a breech adapter and a launch tube. (See
Figure 1-6 on page 1-10.) The accessory kit includes two 3-inch U-bolts, a toggle pin with
an attached lanyard, a 1/4-20 machine screw and flat washer, and a snap bolt. A canvas
cover and a bronze clip to secure it is also provided to protect the launcher when not in
use. The launcher assembly slips into the top of the stanchion and is retained by the toggle
pin. The launcher assembly can also be rotated for stowage alongside the rail so that it will
not be damaged when docking. Refer to Figure 3-4 on page 3-7 when mounting the
launcher.

To Mount the LM-2A:

1. Position the launcher stanchion upright against a rail post of up to three inches in 
diameter such that when the launcher assembly is installed, the launch tube will 
extend beyond the edge of the deck.

2. Orient the launcher so that the axis of the two 9/16” diameter toggle pin holes near 
the top of the stanchion are 35° to 55° from the centerline of the ship toward the 
stern if the launcher is side mounted, or approximately 90° if stern mounted.

NOTE  After installing the LM-2A Deck-Mounted Launcher, cover the launcher
with the canvas cover provided in the accessory kit with the launcher when the
launcher is not in use. Secure the cover with the bronze clip, also provided.
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3. Using the U-bolts, secure the stanchion such that there will be sufficient room to 
insert the toggle pin, to fully open the breech and to insert canisters into the launcher.

4. Install the launcher assembly by inserting its X-shaped mounting boss into the 
stanchion.

5. Insert the toggle pin through the stanchion and mounting boss to prevent the launcher 
assembly from rotating.

6. Secure the free end of the toggle pin lanyard to the tapped hole in the stanchion with 
the 1/4-20 machine screw and flat washer.

7. Using the snap bolt, secure the launcher with a safety line attached from the hole on 
the top of the breech adaptor to the ship’s structure.

FIGURE 3-3:  LM-2A Deck-Mounted Launcher Mounting Locations
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3.2.2 Grounding the LM-2A
To ensure reliable data acquisition, the LM-2A launcher must be connected to a good
seawater ground. To ground the launcher when the ship’s deck is made of metal, weld
a grounding lug to the deck and attach the ground strap to it as shown in Figure 3-4.
For non-metal decks, use a 12 AWG or larger wire and connect it between the 1/4-20
machine screw on the breech to the ship’s plumbing or to the rudder shaft.

3.2.3 Routing the LM-2A Launcher Cable
Route the LM-2A launcher cable to the connector box and connect the cable to it as
described in “Connecting the Launcher Cable to the MK21 Interface Board” on page 3-2.
If the launcher cable will pass through bulkheads or beams, install proper sized bushings
and packing to preserve watertight integrity. The cable must also be properly supported
and strapped to prevent insulation damage. Allow sufficient slack at each end to permit
installation or repair of connectors without installation of new cables.

FIGURE 3-4:  LM-2A Deck-Mounted Launcher Installation Guide

NOTE  If an adequate seawater ground connection cannot be made at the
LM-2A launcher, then make the ground connection at the connector box as
described in “Connecting the Launcher Cable to the MK21 Interface Board” on

page 3-2. If you make the ground connection at the connector box, be sure you do not
attach the launcher ground strap to ground. Doing so will create an undesired ground
loop.
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3.3 Unpacking and Installing the LM-3A
Hand-Held Launcher

Unpack the LM-3A Deck-Mounted Launcher and inspect it for damage. Report any
damage to Sippican. Do not install or operate the launcher if it appears damaged.

The LM-3A is a light weight, portable launcher that allows you to easily position it such
that it does not interfere with other equipment. (See Figure 1-7 on page 1-11.) It should be
used on the stern or on the port or starboard quarter, and it should be held far enough over
the side of the ship to ensure the wire does not come in contact with the ship.

As the LM-3A is portable, the only installation requirements are to route and connect the
launcher cable to the connector box as described in “Connecting the Launcher Cable to the
MK21 Interface Board” on page 3-2.

If the launcher cable will pass through bulkheads or beams, install proper sized bushings
and packing to preserve watertight integrity. The cable must also be properly supported
and strapped to prevent insulation damage.

3.4 Unpacking and Installing the LM-4A
Hull-Mounted Launcher

Unpack the LM-4A Hull-Mounted Launcher and inspect it for damage. Report any
damage to Sippican. Disassemble the launcher by removing the 5/8" studs. Do not install
or operate the launcher if it appears damaged.

The LM-4A is intended for a permanent installation, as it penetrates the ship’s hull and
requires that the launcher be welded to the opening in the hull. The launcher should be
mounted such that the launch tube penetrates the hull a minimum of three feet above the
water line of the ship on the port or starboard quarter, and in an area where it does not
interfere with other equipment.

Installation the LM-4A encompasses the following:

• Mounting

• Grounding 

• Routing the launcher cable

NOTE  You must make the seawater ground connection for the LM-3A
launcher at the connector box as described in “Connecting the Launcher Cable
to the MK21 Interface Board” on page 3-2.

NOTE  Headphone or voice communications to the area where the computer is
located is recommended to allow coordination between the operators of the
computer and the launcher.
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3.4.1 Mounting the LM-4A
The LM-4A Thru-Hull Launcher includes a breech and a breech adapter that are similar to
the LM-2A Deck-Mounted Launcher. (See Figure 1-8 on page 1-12.) The launch tube,
which penetrates the hull, is made of urethane and is mounted to a manually operated ball
valve and a ship’s adapter. The adapter, which is welded to the interior plating of the ship,
provides a rigid mount for the launcher. Refer to Figure 3-5 and Figure 3-6 when
mounting the launcher.

To Mount the LM-4A:

1. Mount the ship’s adapter to the hull.

2. Install the 5/8" studs in the ship’s adapter.

3. Insert the urethane launch tube into the ship’s adapter.

4. Place the ring washer over the studs and seat the washer on the face of the launch 
tube.

5. Mount the ball valve on the 5/8" studs in such a way as to permit operation of the ball 
valve handle without interference from the ship’s surrounding structures and 
framework.

6. Install the breech adapter assembly and secure it with 5/8" nuts, two per stud.

3.4.2 Grounding the LM-4A
To ensure reliable data acquisition, the LM-4A launcher must be connected to a good
seawater ground. Attach the ground strap, which is attached to the 1/4-20 machine screw
on the breech, to one of the 5/8" studs as shown in Figure 3-5.

NOTE  Installation of the LM-4A Thru-Hull Launcher requires penetrating the
ship’s hull. A shipfitter should refer to the detailed installation information
available from Sippican when installing the LM-4A. The procedure below is

provided as a guide.

NOTE  If an adequate seawater ground connection cannot be made at the
LM-4A launcher, then make the ground connection at the connector box as
described in “Connecting the Launcher Cable to the MK21 Interface Board” on

page 3-2. If you make the ground connection at the connector box, be sure you do not
attach the launcher ground strap to ground. Doing so will create an undesired ground
loop.
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FIGURE 3-5:  LM-4A Thru-Hull Launcher Installation Guide
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FIGURE 3-6:  LM-4A Thru-Hull Launcher Installation Notes
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3.4.3 Routing the LM-4A Launcher Cable
Route the LM-2A launcher cable to the connector box and connect the cable to it as
described in “Connecting the Launcher Cable to the MK21 Interface Board” on page 3-2.
If the launcher cable will pass through bulkheads or beams, install proper sized bushings
and packing to preserve watertight integrity. The cable must also be properly supported
and strapped to prevent insulation damage. Allow sufficient slack at each end to permit
installation or repair of connectors without installation of new cables.

3.5 Verifying System Operation
After installing the components of the MK-21/ISA Bathythermograph Data Acquisition
System, you should verify the proper operation of the system by testing the system using
an XBT or XCTD-1 Test Canister. You should perform this test before launching an
actual probe. The test verifies the proper operation of the launcher, the cabling, the MK21
interface board, and the WinMK21 Data Acquisition and Post-Processing Software.

3.5.1 Verifying Operation using an XBT Test Canister
To verify operation using an XBT Test Canister:

1. Turn on the computer, start WinMK21 and wait until the WinMK21 Main window 
opens.

2. Choose Probe from the Options menu, and then choose Selection. The Select Surface 
Probe Type dialog box opens. Select an XBT probe type by clicking its option button, 
and then click OK.

The probe type is selected and the Select Surface Probe Type dialog box closes.

3. Do one of the following to initiate a new probe drop:

• Click the New Drop button.

• Choose New Drop from the File menu.

The Realtime Data Acquisition window opens with "Load Probe" displayed in the 
Acquisition State panel, and the probe type displayed in the Launch Information 
display.

4. Insert the XBT Test Canister into the launcher.

NOTE  If "Spent Canister" is displayed in the Acquisition State panel instead of
"Load Probe," a spent canister is in the launcher. Remove the canister and the
display should change to "Load Probe."
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5. For an LM-3A Hand-Held Launcher, swing the contact lever down; for an LM-2A 
Deck-Mounted Launcher or an LM-4A Thru-Hull Launcher, close the breech.

Immediately after the launcher pins make contact with the contacts in the canister, the 
display in the Acquisition State panel of the Realtime Data Acquisition window 
changes to "Testing Probe" for a few seconds, then to "Prepare for Launch" for 
another few seconds, and then to "Launch Probe." 

6. For an LM-3A Hand-Held Launcher only, connect the release pin of the XBT Test 
Canister to the ship’s hull or other metal ground using a clip lead.

"Collecting MK21 Data" is displayed in the Acquisition State panel of the Realtime 
Data Acquisition window and data acquisition begins as if a real probe has been 
launched. Data acquisition continues until the probe's terminal depth is reached or the 
test is terminated. A temperature data profile appears in the Graphics display, and the 
data are also displayed numerically in the Launch Information display.

7. Verify that the displayed temperature value is 1.5°C (±0.1°C).

8. To terminate the test before the end of the simulated probe drop, choose Terminate 
from the Actions menu. "Spent Canister" is briefly displayed in the Acquisition State 
panel, and then WinMK21 automatically switches to Post Processing mode.

3.5.2 Verifying Operation using an XCTD-1 Test Canister
To verify operation using an XCTD-1 Test Canister:

1. Turn on the computer, start WinMK21 and wait until the WinMK21 Main window 
opens.

2. Choose Probe from the Options menu, and then choose Selection. The Select Surface 
Probe Type dialog box opens. Select the XCTD-1 probe type by clicking its option 
button, and then click OK.

The probe type is selected and the Select Surface Probe Type dialog box closes.

3. Do one of the following to initiate a new probe drop:

• Click the New Drop button.

• Choose New Drop from the File menu.

The Realtime Data Acquisition window opens with "Load Probe" displayed in the 
Acquisition State panel, and the probe type displayed in the Launch Information 
display.

NOTE  If "Spent Canister" is displayed in the Acquisition State panel instead of
"Load Probe," a spent canister is in the launcher. Remove the canister and the
display should change to "Load Probe."
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4. Activate the XCTD-1 Test Canister electronics by switching on the toggle switch on 
the end of the canister. An indicator should illuminate.

5. Insert the XCTD-1 Test Canister into the launcher.

6. For an LM-3A Hand-Held Launcher, swing the contact lever down; for an LM-2A 
Deck-Mounted Launcher or an LM-4A Thru-Hull Launcher, close the breech.

Immediately after the launcher pins make contact with the contacts in the canister, the 
display in the Acquisition State panel of the Realtime Data Acquisition window 
changes to "Testing Probe" for a few seconds, then to "Prepare for Launch" for 
another few seconds, and then to "Launch Probe."

7. Verify that the serial number of the XCTD-1 Test Canister is displayed in the Launch 
Information display. The serial number is printed on the side of the test canister.

"Collecting MK21 Data" is displayed in the Acquisition State panel of the Realtime 
Data Acquisition window and data acquisition begins as if a real probe has been 
launched. Data acquisition continues until the probe's terminal depth is reached or the 
test is terminated. Temperature and Conductivity data profiles appear in the Graphics 
display, and the data are also displayed numerically in the Launch Information 
display.

8. Verify that the displayed temperature and conductivity values are correct to within 
the stated tolerances. These values are printed on the side of the test canister.

9. To terminate the test before the end of the simulated probe drop, choose Terminate 
from the Actions menu. "Spent Canister" is briefly displayed in the Acquisition State 
panel, and then WinMK21 automatically switches to Post Processing mode.

3.6 Preparing to Reship the Launcher and Probes
If reshipping the launcher or the probes is required, refer to the general procedures
provided below to prepare the items for reshipment.

3.6.1 Preparing to Reship a Launcher
To reship a launcher, first disassemble it, if necessary. Then repackage it securely in a
protective wooden shipping crate. Make sure all of the launcher parts are secured in the
crate so they will not break free during shipment.

After removing a LM-4A Thru-Hull Launcher from the ship’s adapter, fit and secure a
plate to the opening in the adapter to ensure the watertight integrity of the hull.

WARNING  While WinMK21 is testing the probe, 60 VDC is present on the
contact pins of the launcher. Do not remove the test canister while WinMK21 is
testing the probe.
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3.6.2 Preparing to Reship Probes
Probes are usually shipped from Sippican in cases of 12. And each probe is individually
packaged in a protective plastic bag or similar container. When preparing to reship probes,
they should be packaged in their original containers.

3.7 Storing the Launchers and Probes 
The launchers and the probes should be stored in accordance with the instructions
provided below.

3.7.1 Storing the LM-2A Deck-Mounted Launcher
When the LM-2A Deck-Mounted Launcher is not in use, shut and secure the launcher
breech and leave an expended probe canister in the breech to help prevent erosion and salt
water contamination. Secure the launcher to the deck, and cover it with the protective
canvas provided with the launcher. Secure the canvas cover to the deck with chain or
heavy weather-resistant line.

3.7.2 Storing the LM-3A Hand-Held Launcher
When the LM-3A Hand-Held Launcher is not in use, store the launcher indoors in a cool,
dry place. Do not leave the launcher on deck when it is not in use, and do not leave it
exposed to the sun for extended periods. In addition, to prevent oxidation of the launcher
contact pins, leave an expended probe canister in the launcher with the contact lever down.

3.7.3 Storing the LM-4A Thru-Hull Launcher
When the LM-4A Thru-Hull Launcher is not in use, shut and secure the breech and ball
valve on the launcher. Remove the spent probe canister and any wire remaining in the
launch tube. Flood the outer launch tube as directed by individual ship operating
procedures.

3.7.4 Storing Probes
When storing probes on board ship or in a maintenance depot, you should leave them in
their original containers. Store them in a cool, dry place away from wind, spray, and salt
water contaminants. Store them at temperatures from 0°C to 50°C (32°F to 122°F); at or
below 25°C (77°F) is ideal. The ideal storage temperature for XCTD probes is at or below
30°C (86°F).

On each of the probe shipping containers is a "Use Before..." date label. The date is
engraved on the shipping label at the time of manufacture. For an XCTD probe there is
also a recommended "Use Within..." date (e.g., "use within x number of days from date of
manufacture"). Sippican cannot guarantee the performance of an XBT, XSV or XCTD
probe used after the "Use Before..." or "Use Within..." date.
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SECTION 4
OPERATION

ith the computer running the WinMK21 Data Acquisition and
Post-Processing Software, and with the Main window of WinMK21 open, an
XBT, XSV or XCTD probe can be loaded into a launcher and launched. This

section provides step by step instructions on how to turn on the computer, launch a probe
and use WinMK21 to view, acquire, store and post process data from the probe. This
entire launch and data acquisition sequence is illustrated in the flow diagram in Figure 4-1.
For detailed information and instructions on how to use all of the functions provided by
WinMK21, see SECTION 5, “WinMK21 Menus and Commands.” Instructions are also
provided on how to exit from WinMK21 and turn off the computer.

4.1 Turning On the Computer and Starting WinMK21
Before you can launch a probe, the computer must be turned on with WinMK21 started
and the Main window open. You must have also installed the MK-21 ISA driver on your
computer. (See “Installing the MK-21 ISA Driver on Your Computer” on page 2-5.)

To turn on the computer and start WinMK21:

1. Turn on the computer.

Windows NT/2000/XP starts.

2. Double-click the WinMK21 icon ( ) on the Windows desktop to start WinMK21.

After WinMK21 is started, the Main window opens as shown in Figure 4.2.

With the Main window open, WinMK21 is ready to be placed into one of its two operating
modes, Data Acquisition or Post Processing. To launch a probe and to acquire and view
data from it, WinMK21 must be in Data Acquisition mode. 

NOTE  A number of startup options are available including an option which
automatically places WinMK21 in the Data Acquisition mode at startup. For
more information about this option and others, see SECTION 5, “WinMK21

Menus and Commands.”

W
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FIGURE 4-1:  Probe Launch and Data Acquisition Sequence Flow Diagram
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4.2 Exiting from WinMK21 and Turning Off
the Computer

To exit from WinMK21, shut down Windows, and turn off the computer:

1. Do one of the following:

• Choose Exit from the File menu.

• Press Alt+F4.

• Click the Windows close button in the Title bar.

2. Refer to the instructions provided with Windows NT/2000/XP and shut down 
Windows.

3. Turn off the computer.

FIGURE 4-2:  The WinMK21 Main Window
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4.3 Launching a Probe
Before you can launch a probe, the WinMK21 Main window must be open as shown in
Figure 4-2 on page 4-3. In addition, WinMK21 must be in Data Acquisition mode. This
mode is entered by initiating a new probe drop. You may also have to enter the probe type
and edit the launch information if these items have changed since the last probe drop. The
launch sequence is a 11-step procedure as follows:

STEP 1. Initiate a new probe drop.

STEP 2. Select or verify the probe type.

STEP 3. Verify the data file name.

STEP 4. Update or verify the setup parameters.

STEP 5. Load the probe.

STEP 6. Launch the probe.

STEP 7. Wait for terminal depth or stop data acquisition.

STEP 8. Transmit the data.

STEP 9. Perform post processing of data.

STEP 10. Edit the launch information.

STEP 11. Load another probe or exit from WinMK21.

4.3.1 STEP 1—Initiate a New Probe Drop
To initiate a new probe drop, do one of the following:

• Click the New Drop button.

• Choose New Drop from the File menu.

WinMK21 enters Data Acquisition mode and the Realtime Data Acquisition window
shown in Figure 4-3 opens with "Load Probe" displayed in the Acquisition State panel.
The Title bar displays "Realtime Data Acquisition," and the Graphics display appears.

NOTE  If "Spent Canister" is displayed in the Acquisition State panel instead of
"Load Probe," a spent canister is in the launcher. Remove the canister and the
display should change to "Load Probe."
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4.3.2 STEP 2—Select or Verify the Probe Type
If the probe you are launching is different from the previous one launched, you must select
the new probe type. Even if you have not changed the probe type, verify that the correct
probe type, its terminal depth and its depth equation are displayed in Launch Information
display.

To select the probe type, choose Probe from the Options menu, and then choose Selection.
The Select Surface Probe Type dialog box shown in Figure 4-4 opens. Select the probe
type by clicking its option button, and then click OK. The probe type is selected and the
Select Surface Probe Type dialog box closes.

FIGURE 4-3:  Realtime Data Acquisition Window—Load Probe

NOTE  To edit the terminal depth and drop rate coefficients for the selected
probe type, click the More button in the Select Surface Probe Type dialog box.
The Probe Attributes dialog box opens where you can make these changes. For

more information, see SECTION 5, “WinMK21 Menus and Commands.”
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4.3.3 STEP 3—Verify the Data File Name
You should verify the correct file name for the data and the folder in which the file will be
stored. WinMK21 automatically names the file. The name comprises a prefix identifying
the probe type, a sequence number, and the extension .rdf, which is for "raw data file." For
example, a data file named T4_00012.RDF is a file name for a T-4 XBT probe, and the
sequence number is 00012. The prefixes for each of the probe types are listed in Table 4-1. 

To verify the data file name, click the Launch Info button. The Launch Information
window opens:

The name of the data file and the folder in which it is stored, along with other information,
are displayed. If desired, the window can remain open during the launch.

FIGURE 4-4:  The Select Surface Probe Type Dialog Box
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4.3.4 STEP 4—Update or Verify the Launch Information
Along with the data, the following launch information is stored in the .RDF file for each
probe drop:

• Probe type and its terminal depth (entered automatically)

• Drop rate equation used (IGOSS, original or custom)

• Data file name (entered automatically)

• Data path (entered automatically)

• Date and time of launch (entered automatically)

• Sequence number (initialized manually, incremented automatically)

• Probe Serial number (entered manually for XBTs and XSVs, automatically for 
XCTDs)

• Latitude and longitude (entered manually or automatically updated; see SECTION 
5, “WinMK21 Menus and Commands,” for more information)

• Memo of up to 15 lines of up to 68 characters each (entered manually)

• Up to eight custom parameters with assigned values

TABLE 4-1:  Data File Name Prefixes

TYPE PREFIX

T-4 T4_

T-5 T5_

T-6 T6_

T-7 T7_

T-10 T0_

T-11 T1_

T-12 T2_

Fast Deep TF_

Deep Blue TD_

XSV-01 S1_

XSV-02 S2_

XSV-03 S3_

XCTD-1 C3_

XCTD-2 C4_
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To edit or verify the launch information, choose Launch Information from the Options
menu. The Launch Information Parameters dialog box opens as shown in Figure 4-5.

Verify or edit the launch information as required, and then click OK.

To view the updated launch information, click the Launch Info button, which opens the
Launch Information window. You can also open the window by selecting Status from the
Window menu, and then choosing Launch Information. The window can be left open
during the launch. It can also be moved anywhere in the display by dragging its Title bar.

In addition to the launch information, you can modify a number of setup parameters,
which include system, scaling, post processing, navigation input, and data transmit
parameters. For information about these parameters and instructions on how to modify
them, see SECTION 5, “WinMK21 Menus and Commands.”

4.3.5 STEP 5—Load the Probe
Remove the end cap from the canister containing the selected probe type and insert the
canister into the launcher. For an LM-3A Hand-Held Launcher, swing the contact lever
down; for an LM-2A Deck-Mounted Launcher or an LM-4A Thru-Hull Launcher, close
the breech. For a description of the Sippican launchers and how they operate, see
“Launchers” on page 1-10.

Immediately after the launcher pins make contact with the contacts in the canister, the
display in the Acquisition State panel of the Realtime Data Acquisition window changes
to "Testing Probe," during which the probe is tested. When testing is complete, the display
changes to "Prepare for Launch" for a few seconds, and then to "Launch Probe" as shown
in Figure 4-6.

FIGURE 4-5:  The Launch Information Parameters Dialog Box

NOTE  The manually entered information in the Launch Information
Parameters dialog box is stored in the .RDF files for all subsequent probe
drops. Therefore, before launching the next probe, you should update or delete

any manual entries that have changed.
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If the probe is an XCTD, the probe serial number, terminal depth and depth equation that
have been read from the probe’s internal memory are displayed in the Launch Information
window.

If the probe is a T-12, the Serial Number dialog box opens prompting you to enter a valid
8-digit serial number. WinMK21 uses the serial number of a T-12 probe to locate the
calibration coefficients and the calibrated depth for the pressure point calibration located
in the .TCO and .PPT files, respectively, for the probe.

4.3.6 STEP 6—Launch the Probe
With "Launch Probe" displayed in the Acquisition State panel, the probe is ready to be
launched.

To launch the probe, pull the release pin out of the canister.

The following occurs:

• "Collecting MK21 Data" is displayed in the Acquisition State panel of the Realtime 
Data Acquisition window as shown in Figure 4-7.

• Data acquisition begins. 

FIGURE 4-6:  Realtime Data Acquisition Window—Launch Probe

NOTE  To terminate the launch, choose Terminate from the Actions menu.
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• A data profile begins to appear in the Graphics display as shown in Figure 4-7 
where the temperature profile for an XBT probe is displayed. Two profiles are 
displayed, temperature and conductivity, for an XCTD probe.

• The data are displayed numerically in the Launch Information display, 
continuously updated as the probe descends.

4.3.7 STEP 7—Wait for Terminal Depth or Stop Data Acquisition
To acquire all the data possible from a probe drop, you must wait for the probe to
complete its descent by either reaching its terminal depth or hitting the bottom. However,
you can stop data acquisition and save all the acquired data before the probe completes its
descent. This may be desirable, for example, when launching a probe in shallow water. To
stop data acquisition, choose Terminate from the Actions menu. The profiles remain
displayed in the Graphics display, the data are saved to the data file, and "Spent Canister"
is briefly displayed in the Acquisition State panel. Then you are asked if you want to
transmit the data and WinMK21 automatically switches to Post Processing mode as
described below.

4.3.8 STEP 8—Transmit the Data
When the probe reaches its terminal depth, or if data acquisition is stopped, WinMK21
can transmit the data. If WinMK21 has been configured to transmit the data at the end of a
probe drop, a dialog box opens asking you if you want to transmit the data for this probe
drop. To transmit the data, click Yes; otherwise click No. For more information, see
SECTION 5, “WinMK21 Menus and Commands.”

FIGURE 4-7:  Realtime Data Acquisition Window—Collecting MK21 Data
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4.3.9 STEP 9—Perform Post Processing of Data
When the probe reaches its terminal depth, "Spent Canister" is briefly displayed in the
Acquisition State panel and the data are saved to the data file. The profiles remain
displayed in the Graphics display while WinMK21 automatically switches to Post
Processing mode, and the Post Processing window shown in Figure 4-8 opens with the
data file name displayed in the Title bar.

In Post Processing mode you can have WinMK21 calculate sound velocity from XBT or
XCTD data, calculate salinity and density from XCTD data, and transmit the data over the
RS-232 interface of the computer. You can also print the Graphics display together with
the data in the Launch Information display. For instructions on how to perform these and
other tasks, see “Post Processing” on page 4-12, and for more information about all the
functions that can be performed in Post Processing mode, see SECTION 5, “WinMK21
Menus and Commands.”

4.3.10 STEP 10—Edit the Launch Information
Following completion of the probe’s descent, you can edit the launch information to
reflect observations made after launch. The edited data file must be saved to the original
data file, overwriting the data, or saved to a new data file with a different file name.

FIGURE 4-8:  Post Processing Window
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To edit the launch information, choose Launch Information from the Options menu. The
Launch Information Parameters dialog box shown in Figure 4-5 on page 4-8 opens.

Edit the launch information as required, and then click OK. To view the updated launch
information, click the Launch Info button, which opens the Launch Information window.
To save the edited launch information, choose Save from the File menu to save the data to
the original data file. Or choose Save As to open the Save As dialog box, and then create a
new file name and save the data to the new data file.

4.3.11 STEP 11—Load Another Probe or Exit from WinMK21
Launch another probe, or exit from WinMK21 and turn off the computer.

To launch another probe, choose Close from the File menu, and then repeat the launch
sequence for a new probe. To exit from WinMK21 and turn off the computer, see “Exiting
from WinMK21 and Turning Off the Computer” on page 4-3.

4.4 Post Processing
You can enter Post Processing mode in two ways: automatically at the end of a probe drop
or by opening a data file. In Post Processing mode you can perform the following major
functions:

• Open a data file.

• View the data profiles and numeric displays.

• Scale and Zoom in on the Graphics display.

• Compare two data profiles.

• Display tabulated data.

• Filter the data.

• Edit the launch information.

• Print the data profiles.

• Generate an export file.

• Transmit the data file.

A number of other functions can be performed in Post Processing mode. For information
about these features and how to work with them, see SECTION 5, “WinMK21 Menus and
Commands.” 

NOTE  It is not advisable to change the sequence number displayed in the
Sequence # text box.
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4.4.1 Opening a Data File
To open a data file, select Open from the File menu. The Open dialog box opens. Select
the data file, a file with extension .rdf, and then click OK.

The Post Processing window opens with the name of the data file displayed in the Title
bar as shown in Figure 4-9. The data profiles are displayed in the Graphics display, and
the Launch Information window displays information about the probe drop, including the
probe type, its terminal depth, its depth equation, its sequence number, and its serial
number.

NOTE  You can select only files with extension .rdf. In addition, the file name
prefix identifies the probe type. The prefixes for each of the probe types are
listed in Table 4-1 on page 4-7. 

FIGURE 4-9:  Post Processing Window
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4.4.2 Viewing the Data Profiles and Numeric Displays
The data profiles are displayed in the Graphics display when you open a data file as shown
in Figure 4-9. To view the numeric displays at any depth, place your pointer inside the
Graphics display. A horizontal line appears. Move the pointer up and down to view the
numeric data in the Tabular Data display for any depth. The horizontal line moves with the
pointer and the displayed depth changes with the vertical position of the pointer. Moving
the pointer off the graph, either to the left or to the right, fixes the displayed depth.

To view the derived sound velocity profile from an XBT or XCTD data file, choose Sound
Velocity from the Profile menu, or right click anywhere in the Graphics display and
choose Sound Velocity. The sound velocity data profile is displayed. To return to the
original display, choose Original from the Profile menu, or right click anywhere in the
Graphics display and choose Original.

To view the derived salinity or density data profile from an XCTD data file, choose
Salinity or Density from the Profile menu, or right click anywhere in the Graphics display
and choose Salinity or Density. The salinity or density data profile is displayed. To return
to the original display, choose Original from the Profile menu, or right click anywhere in
the Graphics display and choose Original.

4.4.3 Scaling and Zooming in on the Graphics Display
The horizontal scaling of the Graphics display can be adjusted to provide greater display
resolution. Scaling can be performed on any data profile, including derived data profiles.
To scale the Graphics display, select Scaling from the Profile menu, and then choose Set.
Or instead, right click the Graphics display thumbnail and choose Scaling. The
Graph Scaling - Defaults dialog box opens. Enter the minimum and maximum values for
the Graphics display, and then click OK.

Any area of the Graphics display can be selected to zoom in on. To zoom in on the
Graphics display, click and hold the left pointing device button and drag the pointer to
draw a box around the area of the Graphics display you want to zoom in on as shown in
Figure 4-10. Then release the button. The zoomed in area is displayed in the Graphics
display as shown in Figure 4-11. A view box representing the zoomed in area relative to
the entire profile is also displayed in the Graphics display thumbnail. You can pan the
Graphics display by dragging and dropping the view box anywhere in the Graphics
Display thumbnail. To return to the original display, choose Original from the Profile
menu, or right click anywhere in the Graphics display and choose Original.

NOTE  The sound velocity data profile for an XBT is based on an assumed
salinity. To verify the correct salinity, or to change it, choose Post Processing
from the Options menu. For an XCTD the temperature and conductivity data

are sufficient to derive salinity, and therefore do not require that you verify or enter an
assumed salinity.
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FIGURE 4-10:  Selecting an Area of the Graphics Display to Zoom in on

FIGURE 4-11:  Zooming in on an Area of the Graphics Display
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Graphics display
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4.4.4 Comparing Two Data Profiles
To compare two data files, open each file, one after the other. Then choose Tile from the
Window menu. The two profiles are displayed side by side in separate Post Processing
Windows. You can perform all of the post processing functions in either window.

To overlay the two data files, select Overlay from the Profile menu, and then choose Set.
The two profiles are overlaid with the data file that was selected last displayed in a lighter
color. To remove the overlay, select Overlay from the Profile menu, and then choose
Remove. 

4.4.5 Displaying Tabulated Data
You can display both the acquired and derived data in tabular format. To display data in
tabulated format, choose Tabular Data from the Profile menu. The Tabular Data window
opens where you can scroll through the data one line at a time, either from this window or
from the Graphics display. To scroll through the data from the window, drag the vertical
scroll box up or down. To scroll through the data from the Graphics display, move the
pointer up or down in the Graphics display. A horizontal line appears which moves with
the pointer. Moving the pointer off the graph, either to the left or to the right, selects a
single line of data.

4.4.6 Filtering the Data
Data files may be filtered for display and for preparation of export files. Two filter modes
are available: Noise Reduction and Averaging. When noise reduction is selected, each
data point whose value exceeds a selectable threshold is deleted. Averaging includes both
noise reduction and averaging of the noise-reduced data. A data file must be open to filter
the data, and the original data profiles must be displayed. To display the original profiles,
choose Original from the Profile menu.

To apply the Noise Reduction filter, choose Post-Processing from the Options menu, enter
the desired threshold value in the Noise Threshold text box, and then click OK. To display
the noise-reduced data profiles, choose Noise from the Profile menu.

To apply the Averaging filter, choose Post-Processing from the Options menu, enter the
desired number of points over which to average in the Averaging Window text box, and
then click OK. To display the averaged data profiles, choose Averaged from the Profile
menu.

4.4.7 Editing the Launch Information
The launch information in the .RDF file can be edited to reflect observations made after
the launch. After editing the launch information, the edited data file must be saved to the
original data file, overwriting the data, or saved to a new data file with a different file
name.
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To edit the launch information, first open the data file and verify that the file name in the
Launch Information window is correct. Then choose Launch Information from the
Options menu. The Launch Information Parameters dialog box shown in Figure 4-5 on
page 4-8 opens.

Edit the launch information as required, and then click OK. To view the updated launch
information, click the Launch Info button, which opens the Launch Information window.
To save the edited launch information, choose Save from the File menu to save the data to
the original data file. Or choose Save As to open the Save As dialog box, and then create a
new file name and save the data to the new data file.

4.4.8 Printing the Data Profiles
To print the data profiles, choose Print from the File menu. The Print dialog box opens.
Select the printer, and then click OK. The Graphics display, as it is currently displayed,
and the launch information is printed.

4.4.9 Generating an Export Data File
Any .RDF file can be converted into a text-format export data file compatible with
external application software such as spreadsheets. The export file format has the
extension .edf (Export Data File) instead of .rdf (Raw Data File). To create an export data
file, open a raw data file, and then choose Export from the File menu. The Save As dialog
box opens. Select the directory in which the export data file is to be created, and then
create a file name and save the data to the file. The export data file can be opened in a
word processing or spreadsheet program.

4.4.10 Transmitting the Data File
To transmit a data file, choose Transmit from the File menu. A dialog box opens asking
you if you want to transmit the data for this probe drop. To transmit the data, click Yes;
otherwise click No.

NOTE  It is not advisable to change the sequence number displayed in the
Sequence # text box.



This page is intentionally left blank.



5-1

MK-21/ISA  Bathythermograph Data Acquisition System

SECTION 5
WINMK21 MENUS AND COMMANDS

or information on the menus and commands provided by the WinMK21 Data
Acquisition and Post-Processing Software, online Help is provided which is
accessed directly from the Menu bar. Help has all of the Windows Help features,

including hyperlinks which make navigating through the information quick and easy.

To open Help, choose Contents from the Help menu or click the Help button. The contents
of Help are displayed and include the following hyperlinked components:

• WinMK21 System Description

• WinMK21 Data Acquisition

• WinMK21 Software Reference

This section includes the same information provided in the WinMK21 Software Reference
component of the online Help and encompasses the following main topics:

• Real-Time Data Acquisition Window

• Menu Bar

• WinMK21 Tool Bar

• Dialog Overview

• Additional Information Overview

• MK21 Interface Board Port Address

F
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5.1 Real-Time Data Acquisition Window
The Real-time Data Acquisition window shows launch state, i.e. "Load Probe," "Testing
Probe," "Launch Probe," "Collecting MK21 Data," and "Spent Canister," the measured
parameter(s) as a function of depth, and the graphical representation of the data being
collected. This window is invoked by the File|New Drop command. There can be only one
Real-time Data Acquisition window for collecting data. However, other data windows can
display data in Post-Acquisition mode from previous drops.

5.2 Menu Bar
This section provides a discussion of all the commands that are accessible from the menu
bar, which includes the following menus:

• File

• Options

• Actions

• Tools

• Profile

• Window

• Help
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5.2.1 File Menu
The File menu provides commands for displaying the Real-time Data Acquisition
window, opening existing profiles, saving profiles, printing profiles, and exiting the
application.

New Drop Display the Real-time Data Acquisition window.

Open Open an existing profile.

Close Close the current profile.

Save Save the current profile in the Raw Data Format (.rdf).

Save As Save the current profile with a new name in the Raw Data
Format (.rdf).

Export Export the current profile in the Export Data Format (.edf)

Transmit Transmit the current profile to an external device.

Print Setup Set the default printer characteristics.

Print Preview View a sample printout of the current profile.

Print Print the current profile.

Exit Exit WinMK21 application.

5.2.1.1 New Drop
The File|New command creates a new Real-time Data Acquisition window, and makes it
the active window.

5.2.1.2 Open
The File|Open command allows the user to load a Raw Data file (.rdf). The standard
Windows Open dialog will appear from which the user can select the file to be opened.

5.2.1.3 Close
File|Close closes the currently active data window.

5.2.1.4 Save
The File|Save command allows the user to save any changes made to the profile in the
active data window.

NOTE  If the profile data has been modified by the operator an asterik (*) is
appended to the file name in the caption bar of the profile window. The asterik
indicates that the profile data, or more precisely a parameter that affects the

profile display, has been modified since the data file was last saved.
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5.2.1.5 Save As
The File|Save As command allows the user to save the profile in the active data window in
a Raw Data File (.rdf) under a new name, or in a new location on disk. The command
displays the Save File As dialog. The new file name, including the drive and directory, can
be entered. The active window containing this profile is updated with the new name. If an
existing file name is chosen, the user is prompted to indicate if the existing file should be
overwritten.

5.2.1.6 Export
The File|Export command allows the user to save a profile in the Export Data Format (.EDF).
The command displays the Save File As dialog. The new file name, including the drive and
directory, can be entered. If an existing file name is chosen, the user is prompted to indicate
whether the existing file should be overwritten.   

5.2.1.7 Transmit
The File|Transmit command allows the transmission of the current profile to an external
device using the currently selected Data Transmit parameters. These options can be
accessed by selecting Options, and then Transmit from the menu bar.

During the data transmission, the Transmit Status dialog is displayed. The Transmit Status
dialog allows the operator to monitor the completion status of the transmission as well as
monitor the integrity of the data transmission.

The binary values and the interpreted values of the transmitted data are displayed on the
dialog.
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The bottom bar indicates the number of bytes in the operating system's output buffer.
Under correct operating conditions this bar will appear empty since the data bytes in the
output buffer should be transmitted as soon as they are sent to the output buffer. However,
if the transmission serial settings do not allow the data bytes to be transmitted as fast as the
WinMK21 application sends them to the output buffer, the output buffer will fill up. The
short bar to the right of the bottom bar indicates if the output buffer has overflowed. Even
if the output buffer is no longer full, this indicator will remain highlighted in order to
indicate the overflow situation. An overflow situation will indicate a transmission failure.
In this case, the baud rate of the transmit serial settings should be increased. The bottom
square to the right of the two indicators flashes when activity is detected on the operating
system's output buffer.

5.2.1.8 Print Setup
The File|Print Setup command displays the Printer Setup dialog which allows the user to
select and configure the current printer.

5.2.1.9 Print Preview
File|Print Preview opens a special window that shows how the profile in the active
window will appear when printed. The preview window shows the data profile as it would
be laid out on the printer page.

5.2.1.10 Print
The File|Print command prints the profile of the active window. Use File|Print Preview to
see how the profile in the active window will appear when printed. Use File|Print Setup to
select a printer and to set printer options.

5.2.1.11 Exit
The File|Exit command exits the WinMK21 program.

5.2.2 Options Menu
The Options menu provides commands for setting the WinMK21 options.

Probe Displays pop-up menu for probe settings - selection of probe
type and probe attributes.

System Set display units, storage mode and hardware settings for the
MK21 interface board.

Transmit Set data transmission settings.

User Set user interface settings

Scaling Set profile scaling settings.

Post-Processing Set profile post-processing parameters.
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Launch Information Set launch information for the active profile

Navigation Input Set navigation input parameters

5.2.2.1 Probe - Selection
There can be only one active probe type for the Data Acquisition mode. When a new
probe drop has been initiated, the system will use the currently active probe type by
default. Thus, if an XSV-01 probe is the currently selected data acquisition probe type,
when the user starts a new drop sequence, the system will prepare the MK21 interface
board for an XSV-01 probe. Therefore, the first step in starting a new drop is to ensure the
desired probe type is actually the currently selected data acquisition probe type. If a
different probe is desired, click Options, then Probe, then Selection. The following dialog
appears which allows the user to select a different probe.

Simply click on the desired probe, and then click OK. Clicking the More button displays
the Probe Attributes dialog for the currently selected probe. Clicking the Default button
resets the attributes of all of the probes to their corresponding default values. The Default
button is disabled if all of the probe attributes are currently set to their default values.
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5.2.2.2 Probe - Attributes
In Data Acquisition mode, the probe attributes are displayed by clicking the More button
in the Probe Selection dialog. In Data Acquisition mode, changes made to the probe
attributes will affect all subsequent profiles that use the edited probe type.

In Post Processing mode, select Options, Probe, and then Attributes menu items to display
the attributes for the probe in the currently active profile. The Attributes menu item is only
available in Post-Processing mode. In Post Processing mode, changes made to the probe
attributes are specific to the probe in the currently active profile only.

Probe Attributes Dialog.  The Probe Attributes dialog allows the user to edit the probe's
terminal depth as well as verify or modify drop rate coefficients (Original, IGOSS, or
Custom). The IGOSS drop rates are the preferred drop rates. Unless there is a special need
for the use of custom coefficients it is best to use the default coefficients for all of the
probe types. Furthermore, in Post Processing mode, the user will be able to define
Pressure Pt and Calibration coefficients if they are available. The following dialog is
displayed:

The probe type, in this case a T-4, is displayed in the caption bar of the dialog.
Furthermore, a picture of the probe is displayed to avoid confusion. If the user changes
any of the values in this dialog, they can be reset back to the default values by clicking the
Default button. Note that this dialog will have a different appearance for each probe type.
For example, the XCTD Deep probe can use a Multi-Stage Equation in calculating the
depth. The Probe Attributes dialog for the XCTD Deep probe is as follows:
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For the XCTD Deep probe, the user can decide to use the standard equation like other
probe types, or the Multi-Stage Equation. Unless instructed by Sippican, Inc., or if there is
a special need for the use of the Multi-Stage Equation, it is best to use the Standard
Equation with the default coefficients.

In another special case, the XCTD-1 probe transmits the terminal depth and drop rate
coefficients from an EEPROM on the probe during the probe loading process. Thus,
unlike all of the other probes, the user is not able to set the probe specific parameters prior
to initiating an XCTD-1 probe.

Post-Processing Attributes.  In Post Processing mode, the user will be able to define
the calibrated depth of the pressure point and edit the data calibration coefficients. If the
feature is supported by the probe, a corresponding button appears in the dialog for the
Pressure Point and Calibration Coefficients dialogs. Clicking the Pressure Pt. button
displays the Pressure Point dialog. Correspondingly, clicking the Cal. Coeff. button
displays Calibration Coefficients dialog.
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5.2.2.3 Probe Attributes - Pressure Point
The Pressure Point dialog allows the user to define the calibrated depth of the probe's
pressure sensor. Furthermore, the user can manually modify or remove the trigger depth of
the pressure point.

The calibrated depth is recorded as a pressure in psi. The calibrated depth in psi is then
converted to a depth in meters (or feet depending on the current units). If the latitude of the
probe drop is available, the WinMK21 will automatically compensate the psi to meters
conversion based on the known latitude.

The trigger depth is displayed in meters (or feet). If this value is blank, then the pressure
point is considered to be “Free.” Otherwise, this value reflects the current trigger depth
whether it was obtained automatically using Auto-Find or set manually by the user. To
remove the trigger depth for the pressure point, simply remove the value and leave the
field blank.

If the trigger depth is set, the resulting correction coefficient is displayed. The correction
is indicated as a required percentage change that must be applied to the derived depth in
order to force the trigger depth of the pressure point signature in the probe data to be
located correctly at the calibrated depth of the pressure sensor.

Clicking the Default button resets the calibrated depth to the default value. 

Clicking the Update button allows the user to update the calibrated depth from the
corresponding .PPT file, in which the eight-digit serial number of the probe is used for the
filename of the .PTT file. If the corresponding .PPT file cannot be located automatically
by the WinMK21, the user is prompted to search for the .PPT file manually.
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5.2.2.4 Probe Attributes - Calibration Coefficients
The Calibration Coefficients dialog allows the user to modify the data calibration
coefficients used by WinMK21 to convert the raw data collected by the probe's sensors to
engineering units. The calibration coefficients, which are only used for analog XCTD,
digital XCTD and T-12 probes are determined during the probe load sequence.

5.2.2.5 Analog XCTD and XCTD Deep Calibration Coefficients
The user may select either Actual, Generic or Custom calibration coefficients for both the
temperature and conductivity calibration coefficients. The Actual coefficients are defined
during the probe load process either directly from the EEPROM on the probe or from the
probe's corresponding .CON file. If the Actual coefficients are not available, the user can
elect to use Generic coefficients for the data acquisition process. The user can also enter
Custom coefficients, however, this is not recommended unless otherwise instructed by
Sippican, Inc. You cannot edit either the Actual or Generic coefficients.

Clicking the Update button allows the user to update the calibration coefficients from the
corresponding .CON file, in which the eight-digit serial number of the probe is used for
the filename of the .CON file. If the corresponding .CON file cannot be located
automatically by the WinMK21, the user is prompted to search for the .CON file
manually.

5.2.2.6 Digital XCTD Calibration Coefficients
The Actual coefficients for the digital XCTD probes are defined during the probe load
process directly from the EEPROM on the probe. If the Actual coefficients are not
available from the EEPROM, you cannot continue with the data acquisition process. The
user cannot elect to use Generic coefficients for the data acquisition process. In Post
Processing mode the user can enter Custom coefficients, however, this is not
recommended unless otherwise instructed by Sippican, Inc. You cannot edit the Actual
coefficients.
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5.2.2.7 T-12 Calibration Coefficients
The user may select either Actual, Generic or Custom calibration coefficients for the
temperature calibration coefficients. The Actual coefficients are defined during the probe
load process from the probe's corresponding .TCO file. If the Actual coefficients are not
available, the user can elect to use Generic coefficients for the data acquisition process.
The user can also enter Custom coefficients, however, this is not recommended unless
otherwise instructed by Sippican, Inc. You cannot edit either the Actual or Generic
coefficients.

Clicking the Update button allows the user to update the calibration coefficients from the
corresponding .TCO file, in which the eight-digit serial number of the probe is used for the
filename of the .TCO file. If the corresponding .TCO file cannot be located automatically
by the WinMK21, the user is prompted to search for the .TCO file manually.
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5.2.2.8 System Parameters
The system parameters include options to modify the MK21 interface board port address,
select whether the data is to be displayed in metric units or English units, and determine
how and where the collected data is to be stored. Select Options, and then System to
display the dialog for these options:

MK21 Interface Board.  In the MK21/USB configuration, the port address may be
modified by the WinMK21 application. Click the Settings button to display the MK21
Interface Board Port Address dialog to modify the port address. The user cannot modify
the port address if the MK21 interface board is in Ready mode. A properly functioning
MK21 interface board in Ready mode indicates that the port address is correct and that it
does not need to be modified.

In the ISA configuration, the port address is maintained by the MK21 device driver and
cannot be changed by the WinMK21 application. In Windows NT a separate utility,
SetMK21, is provided to modify the port address setting for the device driver. However,
you can view the designated port address in this dialog. In Windows 2000/XP, the port
address is modified using the Device Manager.

Please refer “MK21 Interface Board Port Address” on page 5-54 for information on
changing the port address.

Units.  To select the units in which the data is to be displayed, simply click either the
Metric or the English option. 
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Data Storage.  Click either the Standard button or the Export button to indicate the
storage mode.

Standard All unprocessed (raw) acquired data will be stored in the
designated data directory. Raw data files have the extension
.rdf. 

Export All unprocessed (raw) acquired data and an additional export
file will be stored in the designated data directory. Export files
are recorded as text files using ASCII characters for use by
other applications such as spreadsheets. The export file will be
stored in the same directory as the associated raw data file, and
under the same name, but with the extension .edf rather than
the raw data file's .rdf extension. 

Select the Automatically backup data check box to create a second raw data file that is
written to the designated backup directory automatically. If the Export mode is currently
selected, a second export data file will also be written to the backup destination.

The user can select the data and backup directories by selecting the corresponding Browse
button. The following dialog will appear:

The user can select the directory by navigating through the directory structure until the
desired directory has been found, and then clicking the OK button. The newly selected
path will be displayed in the System Parameters dialog.
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5.2.2.9 System Parameters - MK21 Interface Board Port Address
It is possible to change the MK21 interface board port address if the default port address is
not available. Please refer “MK21 Interface Board Port Address” on page 5-54 for
information on changing the port address.

The user cannot modify the port address if the MK21 interface board is in Ready mode. A
properly functioning MK21 interface board in Ready mode indicates that the port address
is correct and that it does not need to be modified. Thus, in order to exercise this option, it
is necessary to make sure that the MK21 interface board is in Standby mode.

5.2.2.10 Data Transmit Parameters
The profile data may be transmitted to an external device via a serial port or an NTDS
interface card. The profile data may be transmitted as follows:

Serial-ASCII: ASCII profile data transmitted via serial port

Serial-Binary: Proprietary binary data format based on NTDS protocol
transmitted via serial port

NTDS-Fast: NTDS protocol (proprietary binary data format) transmitted
via NTDS-Fast interface card

NTDS-Slow: NTDS protocol (proprietary binary data format) transmitted
via NTDS-Slow interface card

To specify the type of external interface select Options, and then Transmit. The Data
Transmit Parameters dialog will appear:
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Enable Data Transmission.  To enable data transmission, the box labeled Transmit
data to external device must be selected. If this box is selected, the profile data from valid
probes will be automatically transmitted to the selected external device at the completion
of a probe drop. The user will always be prompted to confirm the data transmission.
Select the transmit mode depending on the interface to the external interface. Various
options may be set depending on the selected transmit mode.

All Transmit Modes.  All transmit modes allow you to set the Data Record
Transmission Delay. The transmission delay is used to control data flow as required.
Some external readers cannot keep up with an uninterrupted data transmission either
because their input buffer overflows or they are too slow. As a result, they will miss
transmitted data. A variable transmission delay is a simple method to accommodate
slower readers or readers with limited buffering capability. Setting the transmission delay
will help control the data flow should timing between the WinMK21 and the receiver
become a problem by adding a delay in milliseconds between each record that is
transmitted.
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Serial-ASCII Mode.  The Serial-ASCII mode transmits the data via the serial port. The
profile data from all probes may be transmitted in this mode. Click the Settings button in
the Serial - Communications Port section to set the communications port settings. The
Communications Port Parameters dialog will appear. The Serial-ASCII transmit mode
can transmit an extended header prior to the profile data. The extended header information
is similar to the header information in the Export Data Format (.edf) data file.

Serial-Binary Mode.  There are three different protocols available for the Serial-Binary
mode. For more information on the various protocols, see SECTION 6, “Serial-Binary
Data Transmission Description.” The Serial-Binary mode transmits the data via the serial
port. Click the Settings button in the Serial - Communications Port section to set the
communications port settings. The Communications Port Parameters dialog will appear. 

NTDS-Slow Mode.  The NTDS-Slow mode transmits the data via an NTDS-Slow
interface card. In order to remain compatible with existing systems, it may be necessary to
specify an Interval Delay in milliseconds. The interval delay causes the NTDS-Slow
transmission to pause between each byte in a data record transmission. The delay allows
older NTDS readers enough time to read the data value before the next byte in the data
record is transmitted.

Valid Probes for Serial-Binary and NTDS Transmit Modes.  The Serial-Binary,
NTDS-Fast and NTDS-Slow modes transmit the data using a proprietary binary data
format. The protocol only allows the profile data from specific probes to be transmitted as
follows:

Serial-Binary: T-4, T-5, T-6, T-7 and T-10 XBT and XSV-01 and XSV-02
XSV probes; however, not all of the listed probes are available
for all Serial-Binary modes.

NTDS-Fast: T-4, T-5 and T-7 XBT and XSV-01 probes.

NTDS-Slow: T-7 probes only.

Since an XCTD has both temperature and sound velocity information, WinMK21 allows
the profile data to be transmitted as XBT-like or XSV-like. When XCTD data is being
transferred the operator will be asked to specify whether the XCTD data should be
transmitted as XBT or XSV data. The operator is always prompted to specify the data
format with the XCTD Transmit Format dialog; however, this setting is used to set the
default selection.

5.2.2.11 User Interface Parameters
It is possible to control the display upon startup of the WinMK21 software. Click Options,
and User, and the dialog shown below appears which displays the various display options
at startup.
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Clicking the check boxes in the section labeled Start Up Options will display the Launch
Information and System Status dialog at startup. The check box labeled Show active
Probe Drop window will automatically start the program in Data Acquisition mode when
it is enabled. The Status Boxes Toggle Options enable/disable the display of both the
active window with the Launch Information window whenever an active window is
launched, as well as the Real-Time Data Acquisition window with the System Status
window whenever a new data acquisition is launched. General Operations allows the user
to enable or disable verification of critical actions. The Require password to change
settings option allows the user to protect system options with a password.

5.2.2.12 Graph Scaling - Defaults
The minimum and maximum default scaling values for the various profile displays can be
modified prior to probe launch as well as after data acquisition. Click Options, and then
Scaling, and the following dialog appears:

If the any of the values have been modified, clicking the Default button will return the
values back to their associated defaults.
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5.2.2.13 Post-processing Parameters
Noise spike removal and a moving average can be done to profiles. The noise threshold
value and the number of points in the average are user selectable. Implementation of the
noise spike removal and averaging can be selected to be automatic at the end of data
collection. The Post-processing Parameters dialog allows the user to set the
post-processing settings such as the default salinity for XBT sound velocity calculations,
the noise threshold and averaging window and the automatic profile calculation settings.

Select Options, and then Post-processing. The dialog below displays the values used to do
subsequent calculations with data profiles.

5.2.2.14 Launch Information Parameters 

The Launch Information Parameters dialog displays the information related specifically
to the currently active profile. Select Options, and then Launch Information, and the
dialog appears as follows:
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This dialog displays the:

Sequence #: The sequence number is initialized manually, but incremented
automatically. Fill in the field labeled Sequence # to initialize
this parameter.

Serial #: Each probe is assigned a unique serial number at the time of
manufacture. The serial number must be entered manually for
XBTs and XSVs. However, the serial number, which is stored
on the probes' EEPROM, is entered automatically for XCTDs.

Latitude/Longitude: The latitude and longitude at which the probe is dropped can
be defined by the user. The position information can be
entered automatically by an external navigational device as
outlined in the Navigation Input parameters.

Memo: A memo can be entered manually. Enter the desired text in the
field labeled Memo. Note that typing the carriage return key or
the enter key is similar to clicking the OK button. The cursor
can be placed on a new line in this field by typing <Ctrl>
Return, or <Ctrl> Enter.

Custom Fields: Since some users might want to store additional information
with each probe drop, it is possible to define up to eight
custom parameters which can then be assigned values. A
labeled field will appear in the Launch Information window
for each parameter, and a value can then be entered according
to the needs of the user.
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5.2.2.15 Launch Information - Custom Information Labels 

The Custom Information Labels dialog allows you to define additional custom labels to
display user-specific information in the Launch Information window. Any new operator
defined parameters, such as Operator ID and Station ID, appear in the Launch Information
Parameters dialog.

To open the Custom Information Labels dialog, click the More button in the Launch
Information Parameters dialog. 

It is possible to define up to eight custom information labels which can then be assigned
values. A labeled field will appear in the Launch Information window for each parameter,
and a value can then be entered according to the needs of the user. Furthermore, the
information recorded in these custom fields is included in the exported data files.

The value entered into each of the fields will serve as the label for an operator defined
parameter. It is not necessary to enter a value for each of the fields in this dialog. If a value
has been entered into only three fields, then there are likewise three operator defined
parameters. Once the user is finished and the OK button has been clicked, the new
operator-defined parameters appear in the Launch Information Parameters dialog as
shown below:



Menu Bar 5-21

MK-21/ISA  Bathythermograph Data Acquisition System

Now each parameter can be assigned a value, and that value is stored along with the data
and all other information.

5.2.2.16 Navigation Input Parameters
The WinMK21 program is capable of accepting NMEA 0813 navigational information on
a serial port. WinMK21 is a listener for NMEA 0813 talkers like a GPS or LORAN C, and
accepts GGA, GLL, RMC, RMA and ZDA sentences. When any of the position-related
NMEA 0183 sentences are received by WinMK21, the latitude and longitude information
is displayed in the Launch Information window. The position quality is appended to the
latitude (SPS Mode, Differential GPS, PPS Mode or "Fix not avail. or invalid").
Furthermore, if the time-related ZDA sentence is selected, the internal clock on the host
computer is reset by the date/time of the contents of the ZDA sentence. 

To enable Navigation Input, select Options, and then Navigation Input. The Navigation
Input dialog is displayed as shown below:
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Select the NMEA 0183 option to enable the navigation input option. Select at least one of
the NMEA 0183 sentences that is output by your navigational device so the WinMK21
can look at an incoming serial transmissions for the navigational information. Select the
ZDA option if you want the internal clock on the host computer to be reset by the date/
time of the contents of the ZDA sentence.

The communications port settings are displayed in the Communications Port section.
Click the Settings button to modify the settings. The Communications Port Parameters
dialog will appear.

5.2.2.17 Communications Port Parameters
This dialog allows the operator to set the communications port number, baud rate, parity,
and number of data and stop bits for a serial port. All WinMK21 options that make use of
the serial ports, such as Data Transmit and Navigation Input, allow the operator to define
the communications port using this dialog. 
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5.2.3 Actions Menu
The Actions menu provides commands for initiating an action related to the operation of
the MK21 interface board.

Terminate Terminate the current the operation.

MK21 I/O Board Display pop-up menu for MK21 interface board operations.

5.2.3.1 Terminate
The Actions|Terminate command terminates the current operation. This menu item is only
enabled when a Terminate operation is allowed. For example, the menu item is available
during the data acquisition. Once the terminate operation is initiated, the user is informed
that the data acquisition has been terminated. The program is then reset to a state in which
it is simply checking for the presence of a probe in the launcher.

5.2.3.2 MK21 I/O Board
Selecting MK21 I/O Board from the Actions menu displays a popup menu that allow you
to either manually initiate the MK21 interface board or set the MK21 interface board to
Standby mode.

Initiate Initiate the MK21 interface board.

Standby Set the MK21 interface board to standby mode.

5.2.3.3 MK21 I/O Board - Initiate
After launching the software, the MK21 interface board is held in Standby mode. The
MK21 interface board can be initialized automatically when the user proceeds into data
acquisition, or as a separate event. After installing a MK21 interface board in a new
machine, the user may want to manually initiate a MK21 interface board initialization to
verify the board is functioning properly. To do this select Actions, then MK21 I/O Board,
then Initiate. Initialization of the MK21 interface board takes about 7 seconds and is
accompanied by  "Detect MK21" and "Test MK21" messages. During this time the MK21
board is 

• Confirmed to be detected at the address selected by the software settings, and

• Verified to pass internal diagnostic tests.

If the MK21 interface board should fail to be detected, the base address may be in conflict
with some other process of the computer. Please refer “MK21 Interface Board Port
Address” on page 5-54 for information on changing the port address.

Contact Sippican - Technical Support if the MK21 interface board repeatedly fails one of
the internal diagnostic tests.
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5.2.3.4 MK21 I/O Board - Standby
After a successful initialization, the MK21 interface board is held in Ready mode even
after a data acquisition has been completed. This is indicated by the Ready status shown in
the System Status dialog. Select Actions, then MK21 I/O Board, then Standby to revert the
the MK21 interface board back to Standby mode. However, it is not necessary for the
MK21 interface board to revert to Standby mode. The MK21 interface board can safely
remain in the Ready mode indefinitely.

5.2.4 Tools Menu
The Tools menu provides commands for the WinMK21 diagnostic feature, modifying
fundamental profile attributes and for interacting with the hardware of the MK21 interface
board and probes.

Diagnostic Displays pop up menu for diagnostic feature.

Convert Convert profile probe attributes

Read Probe EEPROM Reads the contents of the EEPROMs on XCTD probes

Update Firmware Updates the firmware of the MK21 interface board

5.2.4.1 Diagnostic
The Tools|Diagnostic command provides commands for setting the diagnostic options.

Log to Disk Toggle diagnostic log to disk feature. 

Settings Set diagnostic settings.

5.2.4.2 Diagnostic - Log To Disk
The Diagnostic|Log to Disk command is a feature which, when enabled, saves certain
selectable information to a file on disk. This information can later be viewed by Sippican
technical support and assists in situations when either the MK21 interface board or the
WinMK21 software does not seemed to be functioning properly. When enabled, a check
mark will appear next to the menu item to indicate that the diagnostic information is
currently being logged to disk. To stop writing the diagnostic information to disk, select
this menu item again.

The Start Diagnostics dialog will appear. This dialog allows the user to select the items to
be included in the diagnostic file header as well as items that are to be recorded
continuously while the file is open.
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The diagnostic information written to disk includes:

Header Information

System: The current operating system and computer configuration

Display: Video Display Configuration

Printer: Printer configuration

WinMK21 DLLs: WinMK21 DLL version information

System Files: WIN.INI and SYSTEM.INI files

Continuously Recorded Information

Navigation Input: Serial input settings and navigational information

WinMK21 Operation: WinMK21 internal operations

WinMK21 Settings: WinMK21 software settings

5.2.4.3 Diagnostic Parameters
If diagnostic information is already being recorded, then a dialog can be opened which
allows the user to change what is being recorded to disk.
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Header Information

System: The current operating system and computer configuration

Display: Video Display Configuration

Printer: Printer configuration

WinMK21 DLLs: WinMK21 DLL version information

System Files: WIN.INI and SYSTEM.INI files

Any Header Information item that has already been written to the file will be gray. This
indicates that this item cannot be removed from the header information once it has been
written to disk.

Continuous Recording

Navigation Input: Serial input settings and navigational information

WinMK21 Operation: WinMK21 internal operations

WinMK21 Settings: WinMK21 software settings

5.2.4.4 Convert
The Convert tool allows the operator to change the probe type of an existing data file. On
occasion a probe is dropped with the incorrect probe type specified in the WinMK21
application. This can occur because all of the probes for each group share the same
electrical characteristics. For example, the WinMK21 application is unable to distinguish
the difference between a T-4 and a T-10. All XBT probes are treated the same by the data
acquisition process in the WinMK21 application. However, it is important to specify the
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correct probe type since each probe within the probe group has unique drop rate
coefficients which directly impact the depth calculation for the collected data.
Furthermore, each probe has a unique terminal depth which determines the end of the data
collection process.

To convert a profile, select Tools and then Convert from the menu bar. The Convert
Profile dialog is displayed for the active profile.

The current probe attributes are listed in the top section. The new probe attributes are
listed in the bottom section. Compatible probe types are listed in the Probe selection box.
The operator can only convert to a probe type that has compatible electrical
characteristics. For example, it is not possible to convert a T-10 to an XSV-01. Upon
selection of a compatible probe type, the probe attributes are listed in the bottom section.
The terminal depth of the current probe attributes are maintained for the new probe
attributes.

Click the Attributes button to specify custom probe attributes for the new probe type.

Upon selecting the OK button, the profile is converted to the new probe type, with the
specified probe attributes. The filename is also converted using the correct prefix for the
new probe type. However, the operator must resave the file to disk.
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5.2.4.5 Read EEPROM (XCTD Probes only)
The Read EEPROM tool reads the contents of the EEPROM on both the analog and
digital XCTD probes. If the active probe is an XCTD probe, then the Read EEPROM tool
will attempt to read the contents of the currently active probe. The active probe is set using
the Probe Selection dialog.

Normally the acquisition and utilization of the contents of the probe EEPROM happens at
the beginning of each launch, and is completely transparent to the user. This feature can be
used as a prelaunch verification check to ensure the system integrity (computer, launcher,
cable connections, and probe) prior to launching the probe. 

Analog XCTD Probes.  The sensors on the analog XCTD probes are individually
calibrated. The calibration coefficients are stored on the EEPROM of each probe and are
used by the WinMK21 application to convert the sampled data into temperature and
conductivity values. The analog XCTD maintains three temperature and three
conductivity calibration coefficients. Furthermore, the EEPROM on the analog XCTD
probes contains the serial number and may contain a Pressure Point calibration value. 
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Digital XCTD Probes.  The sensors on the digital XCTD probes are individually
calibrated. The calibration coefficients are stored on the EEPROM of each probe and are
used by the WinMK21 application to convert the sampled data into temperature and
conductivity values. The digital XCTD maintains four temperature and four conductivity
calibration coefficients. Furthermore, the EEPROM on the digital XCTD probes contains
the serial number, drop rate coefficients and terminal depth for the probe.

Save EEPROM Contents.  Click the Save button to save the EEPROM contents to disk
in ASCII text format. The user will be prompted to specify the filename and location for
the resulting text file.

5.2.4.6 Update Firmware
The MK21 interface board firmware can be updated by the user. This should only be done
when a new release of the firmware has been made available by Sippican. The process for
updating the firmware is simple; however, there are several safeguards in place to prevent
the possibility of inadvertently erasing the existing firmware on the MK21 interface board.
This feature will be used only when new firmware has been provided by Sippican to add
additional capability to the software, or fix a problem that has been identified to be
repairable with a firmware change.
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5.2.4.7 Identifying the Current Firmware Version
The version of firmware resident on a MK21 interface board is identified by the date. To
obtain the version date, select Help, then About, then MK21 I/O Board. The About MK21
Interface Board dialog will be displayed. The version date is specified under Firmware Id.
If the MK21 I/O Board button in the About WinMK21 dialog is grayed out, the MK21
interface board needs to be initialized. To do this, select Actions, then MK21 I/O Board,
then Initiate. Then repeat the previous procedure to obtain the Firmware Id.

To update the firmware:

1. Obtain the MK21 firmware update file from Sippican. This is a file identified with an 
.LDR extension. It may be on a floppy disk, or copied to any disk space accessible by 
the WinMK21 program.

2. Select the Update Firmware menu item from the Tools menu. Using the browser, 
select the .LDR firmware update file discussed in the previous step.

3. The MK21 Firmware Update window prompts the user to set the PROGRAM/RUN 
switch to PROGRAM. This switch is the 2-position toggle switch on the edge 
connector of the MK21 interface board located above the DB-9 launcher cable 
connector and the red/white DIP switch. To set the PROGRAM/RUN switch to 
PROGRAM, toggle the switch in the direction away from the DB-9 launcher cable 
connector.

4. Click OK to proceed with the download.

5. At this point, the update procedure will require you to confirm the desire to continue 
with the firmware update using the specified .LDR file. The version of selected 
firmware update as identified by the date is displayed. This is the last chance to 
cancel the firmware update procedure. Answer Yes to proceed with the firmware 
update. If you select either No or Cancel, the operation will be cancelled.
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6. The firmware update will now be performed. For the ISA configuration, the update 
process takes only a few seconds. However, for the MK21/USB configuration, the 
update process takes considerably longer. A progress dialog is displayed during the 
update process for the MK21/USB configuration.

7. Once the update is completed, the MK21 Firmware Update window prompts the user 
to set the PROGRAM/RUN switch back to RUN. At this time toggle the switch back 
to its original position, in the direction towards the DB-9 launcher cable connector.   
Select OK.

8. The update procedure now indicates that the update has been completed, and 
confirms that the PROGRAM/RUN switch has been set to the RUN position 
properly.

CAUTION  Do not try to perform any other action with the computer during
the update. Do not turn off the computer while the update is in progress.
Otherwise, the firmware on the MK21 interface board may become corrupted

and MK21 interface board may become inoperable.
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5.2.5 Profile Menu
The Profile menu provides commands for setting the profile display options. The Profile
menu item is only available when the Real-time Data Acquisition window is open, or a
previously acquired profile is being displayed.

Scaling Displays pop-up menu for scaling settings.

Tabular Data Toggle display of Tabular Data dialog for the current profile.

Original Display the acquired unfiltered data.

Noise Display the noise reduced data.

Averaged Display the averaged data.

Salinity Display the derived salinity data.

Sound Velocity Display the derived sound velocity data.

Density Display the derived water density data.

Pressure Pt Displays pop-up menu for pressure point settings.

Overlay Displays pop-up menu for overlay settings.

5.2.5.1 Scaling
The Scaling pop-up menu provides commands for setting the scaling options for the
current profile.

Default Set the current profile scaling values to default values.

Auto Set the current profile scaling values automatically.

Zoom Out Zoom out from the current profile scaling settings.

Set Set profile scaling settings.

5.2.5.2 Default Scaling
The Scaling|Default command sets the current profile scaling values to default values. The
default scaling values are set by the Scaling Parameters dialog, accessed either by the
Options|Scaling or Scaling|Set menu items.
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If the profile has been zoomed, it appears as follows:

Selecting the Default menu item from the Profile|Scaling menu redraws the profile as
follows:
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5.2.5.3 Auto Scaling
The Scaling|Auto command sets the current profile scaling values based on the minimum
and maximum values of the profile data. A default profile appears as follows:

Selecting the Auto menu item from the Profile|Scaling menu redraws the profile as
follows:
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5.2.5.4 Zoom Out Scaling
The Scaling|Zoom Out command in the Scaling menu will expand the view of the current
profile by doubling the current scaling values. A zoomed profile appears as follows:

Selecting the Zoom Out menu item from the Profile|Scaling menu redraws the profile as
follows:
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5.2.5.5 Set Scaling
The Scaling|Set command displays the Graph Scaling - Defaults dialog so you can set the
minimum and maximum default scaling values for the various profile displays. This
dialog is also accessed by the Options|Scaling menu item.

5.2.5.6 Tabular Data
The Profile|Tabular Data command toggles the display of the Tabular Data window. This
dialog displays the profile data in a tabular format listed sequentially by depth. A check
mark will appear next to the menu item to indicate the dialog for the active profile is
currently visible. This dialog is shown below.

5.2.5.7 Original Profile
The original profile is a trace of the acquired and unfiltered data. To display the original
profile select the Original menu item from the Profile menu. This action rewrites the
original trace to the graphical display, retaining the current scaling. The acquired data is as
follows for the different probes:

XBT: Temperature

XSV: Sound Velocity

XCTD: Temperature and Conductivity
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5.2.5.8 Noise Reduced Profile
The Noise Reduced profile is a trace of the data with the noise spikes removed. To display
the noise reduced profile select the Noise menu item from the Profile menu. This function
rewrites the trace while retaining the current scaling of the graphical display.

This function is performed by scanning each individual data point, and comparing the
value of that data point with the value of the previous data point. If the difference between
these two values is greater than the Noise Spike Threshold defined in the Post-Processing
Parameters dialog, the current data point will be removed from the Noise Reduced profile.
Subsequent data points are also compared to the last acceptable data point, and removed if
their differences exceed the threshold. As the trace continues to be examined, the
reference point is advanced when the difference drops below the threshold. After the trace
is complete, there is a note in the Post-processing section of the profile window showing
the percentage of points removed. For the XCTD probe, both data sets (conductivity and
temperature) are processed in parallel. If either data set has a value which is suspect, then
that data point is removed from both profiles.

The removal of data points can be influenced through the Noise Spike Threshold as
defined in the Post-processing Parameters dialog. Select Options, and then
Post-Processing to display the Post-processing dialog.

The value in the field labeled Noise Threshold defines the difference between data point
values at which that data point will be removed. Simply enter a new value into this field to
define a new threshold. Note that if the entered threshold value is too small, large voids
can result in the display as groups of valid data points will be removed. Also note that this
function does not modify the raw data file.
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5.2.5.9 Averaged Profile
The Averaged profile is a trace of the data with the data averaged. To display the averaged
profile select the Average menu item from the Profile menu. This function rewrites the
trace while retaining the current scaling of the graphical display.

The WinMK21 application can optionally create a Noise Reduced profile first. Then the
value of each remaining data point is averaged using a variable averaging window.

The averaging of data points can be influenced through the Averaging Window as defined
in the Post-processing Parameters dialog. Select Options, and then Post-Processing to
display the Post-processing dialog.

Enter a valid odd number in the Averaging Window field to change the number of values
used in generating the Averaged profile. If the Automatically calculate Noise-Reduced
Profile option has been selected in the Post-processing Parameters dialog, the acquired
data will be automatically noise-reduced using the current settings before the data is
averaged. Also note that this function does not modify the raw data file.

5.2.5.10 Salinity Profile
The Salinity profile provides computation and display of salinity. This profile display
option is only available for XCTD probes. To display the salinity profile select the Salinity
menu item from the Profile menu. This function rewrites the trace while retaining the
current scaling of the graphical display. If the automatic post-processing options have
been activated in the Post-Processing Parameters dialog, the acquired data will be
automatically noise-reduced and/or averaged using the current settings before the salinity
profile is derived.
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The equation used to calculate salinity as a function of measured temperature,
conductivity and depth is defined by the 1978 Practical Salinity Scale (PSS-78).1, 2, 3

5.2.5.11 Sound Velocity Profile
The Profile|Sound Velocity command computes and displays the derived sound velocity
data in the graphical display. This profile display option is available for both:

XBT probes Using the acquired temperature data and a default salinity
value as set in the Post-Processing Parameters dialog.

XCTD probes Using the acquired temperature and conductivity data.

If the automatic post-processing options have been activated in the Post-Processing
Parameters dialog, the acquired data will be automatically noise-reduced and/or averaged
using the current settings before the sound velocity profile is derived. The spike removal
threshold, the percentage of data points that have been deleted and the size of the
averaging window are displayed in the Post-processing section of the profile window.

The equation used to calculate sound velocity, often known as the UNESCO algorithm, is
due to Chen and Millero.4 For the original UNESCO paper see Fofonoff and Millard
(1983).5

5.2.5.12 Density Profile
The Profile|Density command computes and displays the derived water density data in the
graphical display. This profile display option is only available for XCTD probes.

If the automatic post-processing options have been activated in the Post-processing
Parameters dialog, the acquired data will be automatically noise-reduced and/or averaged
using the current settings before the water density profile is derived. The spike removal
threshold, the percentage of data points that have been deleted and the size of the
averaging window are displayed in the Post-processing section of the profile window.

The equation used to calculate density is defined in the UNESCO paper attributed to
Fofonoff and Millard (1983).5

1. UNESCO Technical Papers in Marine Science, #36 (1981a) “The Practical Salinity Scale 1978 and the
International Equation of State of Seawater 1980,” UNESCO Division of Marine Sciences (Paris), 25pp.

2. UNESCO Technical Papers in Marine Science, #37 (1981b) “Background papers and supporting data on
the practical salinity scale, 1978,” UNESCO Division of Marine Science (Paris), 144pp.

3. 1978 Practical Salinity Scale Equations (January 1980) IEEE Journal of Oceanic Engineering, OE-5 No. 1,
p. 14.

4. C-T Chen and F.J. Millero, Speed of sound in seawater at high pressures (1977) J. Acoust. Soc. AM. 62(5)
pp. 1129-1135.

5. N.P. Fofonoff and R.C. Millard Jr., UNESCO Technical Papers in Marine Science, #44 (1983)
“Algorithms for computation of fundamental properties of seawater,” UNESCO Division of Marine
Science (Paris) 53pp.
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5.2.5.13 Pressure Point - Overview
The Pressure Point pop-up menu provides commands for setting the pressure point trigger
depth for the current profile.

Set Manually set the location of the pressure point signature at the
current profile marker.

Remove Manually remove the trigger depth indicating the pressure
point signature.

Auto-Find Automatically search the probe data for the pressure point
signature.

5.2.5.14 Pressure Point - Set
Select the Set menu item from the Profile|Pressure Pt menu to manually set the location
of the pressure point signature. The trigger depth for the pressure point will be set to the
current depth as indicated by the profile marker. 

The Profile, Pressure Point, Set menu item is only available if the current probe is
pressure point enabled and the calibrated depth of the pressure point has been properly
defined. Only analog XCTD and T-12 probes are pressure point enabled. The calibrated
depth of the pressure point is either read from an analog XCTD probe's EEPROM or from
a .PPT file for both analog XCTD and T-12 probes.

To define the calibrated depth of the pressure point, select the Attributes menu item from
the Options|Probe menu. The Probe Attributes dialog will appear. If the probe is pressure
point enabled the Pressure Pt. button is enabled. Click the Pressure Pt. button to display
the Pressure Point dialog. The user can now define the calibrated depth of the pressure
point for the current probe.

5.2.5.15 Pressure Point - Auto-Find
Select Profile, Pressure Pt, and then Auto-Find from the menu bar to automatically set the
location of the pressure point. WinMK21 will search the probe data for the pressure point
signature. The results of the search are displayed in the Auto-Found Pressure
Confirmation dialog.
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If the user confirms a successful search, the profile data is redrawn with the new corrected
depths. The pressure point signature will be displayed at the calibrated depth and all the
other probe depths will be adjusted accordingly.

5.2.5.16 Pressure Point - Undo
Select Profile, Pressure Pt, and then Undo from the menu bar to manually remove the
trigger depth for the pressure point. This action effectively clears any existing pressure
point correction to the depth equation.

The Profile, Pressure Point, Undo menu item is only available if the current probe is
pressure point enabled and both the calibrated and trigger depth of the pressure point have
been properly defined. Only analog XCTD and T-12 probes are pressure point enabled. 

5.2.5.17 Overlay - Overview
An overlay allows you to view a profile from a previous launch on the graphical display,
but does so using a lighter color than the current profile. The file name of the overlay
profile is indicated in the caption bar of the profile window. 

In some cases the overlay may not be able to draw a matching profile. The probe data in
the selected overlay must be able to automatically calculate the matching data set in order
to draw the overlay profile. For example, the data from an XSV probe drop cannot be used
as an overlay for an XBT because the matching temperature profile cannot be derived
automatically from the XSV data. As another example, the data from an XBT probe drop
can be used as a partial overlay for an XCTD probe because at least the matching
temperature profile is available in the XBT data. 

The Overlay menu provides commands for adding and removing an overlay for the current
profile. 

Set Add an overlay profile.

Remove Remove an overlay profile.

5.2.5.18 Overlay - Set
Select Profile, Overlay, and then Set from the menu bar to add an overlay profile to the
current profile. A dialog will appear which prompts the user to select a .rdf data file of a
previous launch. Once the file is selected, the overlay profile is drawn in the graphical
display using a lighter color than the current profile. Furthermore, the file name of the
overlay profile is indicated in the caption bar of the profile window.    

Select Profile, Overlay, and then Set from the menu bar to replace an existing overlay
profile with a different overlay profile. You do not need to remove the existing overlay
first.
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5.2.5.19 Overlay - Remove
Select Profile, Overlay, and then Remove from the menu bar to remove an existing overlay
profile from the current profile. This menu item is only available if an overlay has been set
for the current profile.

5.2.6 Window Menu
The Window menu provides commands to control the position and layout of the
application's windows.

The Status pop-up menu allows you to toggle the display of the various status windows. A
check mark will appear next to the name of the status window if it is currently displayed.

Launch Information Toggle display of Launch Information window

System Status Toggle display of System Status window

Navigation Input Status Toggle display of Navigation Input Status window

The following menu items allow you organize the profile windows.

Cascade Resize and position all profile windows, with the exception
of the Launch Information, System Status and Navigation
Input Status windows, in an overlapping pattern.

Tile Resize and position all profile windows, with the exception
of the Launch Information, System Status and Navigation
Input Status windows, in non-overlapping pattern.

Arrange Icons Align all iconized windows along a grid.

Close All Close all profile windows.

5.2.7 Help Menu
The WinMK21 application provides online help to assist users in using the WinMK21
software. If there are questions not answered by the online help, additional assistance is
available by contacting Sippican.

The About WinMK21 dialog displays the version information for the application and its
support files. Additional information is listed for the device driver.

Click the Tech. Support button to display information on how to contact the Sippican -
Technical Support. Click the MK21 IO Board button to display the About MK21 IO Board
dialog that displays version information about the MK21 interface board.
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5.3 WinMK21 Tool Bar
The WinMK21 tool bar is a row of buttons at the top of the Main window which represent
application commands. Clicking one of the buttons is a quick alternative to choosing a
command from the menu. Buttons on the tool bar activate and deactivate according to the
state of the application.

Drop a new probe File|New Drop

Open a profile File|Open

Save the profile File|Save

Save the profile with a new name File|Save As

Export the profile in the active window File|Export

Print the profile in the active window File|Print

Toggle Launch Information display Window|Status|Launch
Information

Toggle System Status display Window|Status|System Status

Toggle Navigation Input Status display Window|Status|Navigation
Input Status

Display help file contents Help|Contents
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5.4 Dialog Overview
This section provides information on a few selected dialogs. These dialogs include:

• Launch Information window

• System Status dialog

• Navigation Input Status dialog

5.4.1 Launch Information
The Launch Information window displays the information related specifically to the
currently active profile. This dialog displays the:

Probe Parameters: Probe, Terminal Depth, Drop Rate Equation, Serial number.

Storage Parameters: Data Filename, Data Path.

Launch Parameters: Date and Time, Sequence Number, Latitude and Longitude
position.

Custom Parameters: Custom label and contents if available.

5.4.2 System Status
The System Status window displays the current system status parameters. This dialog
displays the:

MK21 Status: Indicates MK21 interface board state (Ready or Standby).

Nav. Input: Indicates communications port state and settings.

Data Transmit: Indicates if the collected data is to be transmitted to an external
device.
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Storage Mode: Indicates automatic export storage mode (.rdf and .edf) or
standard storage mode (.rdf only).

Disk Space: Indicates amount of free space available in the current default
data path as the number of drops for the currently selected
probe.

Display Units: Indicates universal system units (metric or English).

5.4.3 Navigation Input Status
The Navigation Input Status dialog displays diagnostic information related to the
navigational input parameters and a scrolling display of the incoming serial data on the
active communications port.

The horizontal bars at the bottom of the dialog indicate the status and activity of the two
serial input buffers as follows:

Operating System Input Buffer Status.  The top bar indicates the amount of bytes in
the operating system's input buffer. Under normal operating conditions this bar will appear
empty unless an internal process has temporarily delayed the WinMK21 application's
ability to retrieve the serial information from the operating system's input buffer. The top
square to the right of the indicator flashes when activity is detected on the operating
system's input buffer. 
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Internal WinMK21 Input Buffer Status.  The bottom bar indicates the number of bytes
in the internal WinMK21 input buffer. Under normal operating conditions this bar will
appear empty. However, it is possible for the internal WinMK21 input buffer to begin to
fill up if a lengthy internal process has temporarily delayed the WinMK21 application's
ability to process the data in this input buffer. Once the WinMK21 is able to process the
data in the internal input buffer, the indicator will revert to empty. The bottom square to
the right of the indicator flashes when activity is detected on the internal WinMK21 input
buffer.

The WinMK21 input buffer will fill up if the WinMK21 application is unable to process
the data in the input buffer. This typically occurs if the navigation input serial settings,
such as the baud rate, are not specified correctly for the incoming data stream.

In this example, the navigation input serial settings have been set to a baud rate of 9600.
The incoming data stream from the external navigation device is set to a baud rate of 4800.
The WinMK21 application is still able to read the data from the serial port, however, it is
unable to process the data since it doesn't make any sense because of the incorrect serial
settings. As a result, the internal WinMK21 input buffer simply fills up with the
unprocessed serial data until an overflow is detected. Upon detecting an overflow, the
WinMK21 application clears the internal input buffer and warns the operator of the
possible problem.

Diagnostics.  The Diagnostic button activates the diagnostics feature. If not already
active, a diagnostics file is automatically named and created in the default data directory.
This file will contain diagnostic system information related to the serial communications
and records all incoming serial data and changes to the communications settings. Selecting
the Diagnostic button a second time will stop recording the navigation input information
to the current diagnostics file.
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5.5 Additional Information Overview
This section briefly explains some issues not related to other topics in this help file.

• Restore Storage File

• Configuration Log File

• Password Protection Overview

• Probe Filenames

• Raw Data Format

• Export Data Format

• Depth Equation

• Terminal Depth

• Navigation Input Reference - NMEA 0183

5.5.1 Restore Storage File
WinMK21 automatically creates a temporary restore storage file, MK21RSTR.SIP, in the
default data folder for every probe drop. If the probe drop is completed successfully and
the data is recorded to a valid RDF data file, the temporary restore storage file is
automatically removed. However, if an unexpected error occurs that results in an
incomplete probe drop or an unsuccessful storage of the data in a valid RDF file, the
restore file remains available in the default data folder.

Upon restarting WinMK21, the restore file is automatically detected. The operator is
presented with a list of options as follows:

Upon selecting Yes, WinMK21 will attempt to restore the data from the restore storage
file. If the data recovery is successful, the data profile is displayed in a Data Window. The
operator must manually save the profile to an RDF file. If the data recovery is
unsuccessful, the operator is prompted to store the invalid restore storage file in a new
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location and send the file to the Sippican - Technical Support for further analysis. If the
restore storage file is not moved to a new location, it will be overwritten automatically at
the beginning of the next probe drop.

Upon selecting No, the restore storage file will be deleted immediately.

Upon selecting Cancel the operator is prompted to move the restore storage file to a new
location with an optional new name. This option allows the operator to record multiple
restore storage files.

5.5.2 Configuration Log File
WinMK21 maintains a configuration log file, MK21CFG.LOG, in the Windows directory
of the computer. The configuration log file records the original configuration settings and
any subsequent changes to the WinMK21 settings. The configuration log file should never
be deleted unless specifically requested by the Sippican - Technical Support. Furthermore,
the configuration log file should not be maintained or viewed by the operator. The sole
purpose of the file is to aid the Sippican - Technical Support in determining the original
configuration of the WinMK21 settings and subsequent changes for technical support
situations.

5.5.3 Password Protection
The Password Protection option allows the supervisor to restrict access to specific system
options. The user can only access the restricted options if a valid password is entered. The
password can contain up to 32 context sensitive alphanumeric characters, including
spaces.

The Password Protection option is enabled by selecting the Require password to change
settings option in the User Parameters dialog. The New Password dialog will appear and
the supervisor is prompted to enter a new password. Once a new password has been
activated, a user will be required to enter the password in the Password Protection dialog
to access specific parameters. 

If you have lost or forgotten the supervisor password, contact Technical Support for
assistance.

Password Protection Dialog.  This dialog is presented when you are attempting to
perform an action that is protected by a password. The dialog prompts you to enter the
current supervisor password. If the password is entered correctly, you are allowed to
proceed. If the password is entered incorrectly, you are not allowed to proceed.
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New Password Dialog.  This dialog allows you to set a new password. The new
password must be entered twice to verify the correct spelling. The password can contain
up to 32 context sensitive alphanumeric characters, including spaces.

5.5.4 Probe Filenames
The data filename is constructed automatically from the probe type and sequence number.
The first two characters of each data filename identify the probe type. The table below
shows the prefixes for each probe type:

TYPE PREFIX

T-4 T4_

T-5 T5_

T-6 T6_

T-7 T7_

T-10 T0_

T-11 T1_

T-12 T2_

Fast Deep TF_

Deep Blue TD_

XSV-01 S1_

XSV-02 S2_

XSV-03 S3_

XCTD-1 C3_

XCTD-2 C4_

The numeric portion of the data filename is taken from the sequence number.
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5.5.5 Raw Data Format
The Raw Data Format is a proprietary binary file format of the profile data. This file is the
standard storage format for WinMK21, WinMK12 and the DOS-based MK12
applications. Although WinMK21 is able to convert files generated by the WinMK12 and
DOS-based MK12 applications, the WinMK21 RDF data files are not compatible with the
earlier WinMK12 and DOS-based MK12 applications. As such, the earlier WinMK12 and
DOS-based MK12 applications can not read RDF files generated by WinMK21.

5.5.6 Export Data Format
The Export Data Format is an ASCII output file of the profile data. The file contains
launch and probe information in the header. The complete profile data is then listed in tab-
delimited format with a single data sample set on each line. A single data sample set
consists of the calculated depth and the measured and derived data for each probe, i.e.
temperature, sound velocity, conductivity, etc. An example of such a file is displayed
below.

// This is a MK21 EXPORT DATA FILE  (EDF)
//
Date of Launch:  10/10/2000
Time of Launch:  08:49:38
Sequence #    :  49
Latitude      :  4 0.000S
Longitude     :  4 0.300E
Serial #      :  0
//
// Here are the contents of the memo fields.
//
//
// Here is some probe information for this drop.
//
Probe Type       :  T-4
Terminal Depth   :  460 m
Depth Equation   :  Standard
Depth Coeff. 1   :  0.0
Depth Coeff. 2   :  6.691
Depth Coeff. 3   :  -0.00225
Depth Coeff. 4   :  0.0
Pressure Pt Correction:  100.0%
//
Raw Data Filename:  C:\SIPPICAN\WINMK21\DATA\T4_00049.RDF
//
Display Units    :  Metric
//
// This XBT export file has been noise reduced and averaged.
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Noise Threshold :  10.0 (0.0% spikes)
Averaging Window:  7
//
// Sound velocity derived with assumed salinity: 30.00 ppt
//
Depth (m) - Temperature (°C) - Sound Velocity (m/s)
4.7 20.91 1575.30
5.4 20.91 1575.31
6.0 20.91 1575.32
6.7 20.91 1575.33
7.4 20.90 1575.34
8.0 20.90 1575.35
8.7 20.90 1575.36
...

454.8 9.91 1552.97
455.4 9.91 1552.98
456.1 9.91 1552.99
456.7 9.91 1553.00
457.3 9.91 1553.01
458.0 9.91 1553.02
458.6 9.91 1553.03

5.5.7 Depth Equation
Probe depth is determined as a function of elapsed time after detection of seawater entry.
The general expression for probe depth is a quadratic equation as follows:

Depth= A * time + B * time * time

The linear term is terminal velocity and the second-order term accounts for the slight
reduction in probe mass as its wire dereels, reducing its descent speed as depth increases.
Because probe types vary in geometry and mass, the equation coefficients also vary from
type to type.

WinMK21 maintains a set of drop rate coefficients for each probe. The drop rate
coefficients for all probe types were originally determined by Sippican.   In 1995, The
Integrated Global Ocean Services System (IGOSS) Task Team on Quality Control
Procedures for Automated Systems.1 published an extensive study refining the drop rate
coefficients for the T-4, T-6 and T-7 XBTs. For these probes the IGOSS coefficients have
been implemented as the default values. Where there are no IGOSS coefficients available,
the original Sippican values are used as defaults (IGOSS option is not selectable). Note
that the coefficients can also be modified by the user to custom values. Use of the custom
coefficients is extremely rare and is not recommended without consulting with Sippican -
Technical Support first.

1.  K. Hanawa, P. Rual, R. Bailey, A. Sy, and M. Szabados, A New Depth-Time Equation for Sippican or TSK
T-7, T-6 and T-4 Expendable Bathythermographs (XBT) published in IOC Technical Series No. 42.
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The current selection for drop rate is displayed in the Launch Information window as
Depth Equation. Any selection other than the default selection for a given probe type will
be displayed in red to alert the operator that non-default values are being used. In Data
Acquisition mode, to view or change the drop rate coefficients click on Options|Probe|
Selection|More. In Post Processing mode, click on Options|Probe|Attributes. In either
case the Probe Attributes dialog is displayed for the active probe.

XCTD-Deep Depth Equation.  The XCTD-Deep analog probe allows a multi-stage
depth equation. This is a customized depth equation for use with the XCTD-Deep probe
that divides the probe descent into multiple stages based on time. Each stage has a unique
set of drop rate coefficients and three additional correction factors. The Multi-Stage
equation was designed to model the empirically measured descent of the XCTD-Deep
probe. If required, please contact Sippican - Technical Support for more information on
the XCTD-Deep depth equation.

Digital XCTD Depth Equation.  The digital XCTD probes do not allow the operator to
modify the drop rate coefficients. The drop rate coefficients are stored on the EEPROM
and are determined at the time the probe is loaded in the launcher. The digital XCTD
EEPROM format has allocated space for four drop rate coefficients for use with the depth
equation. However, it is only using two terms, the linear and second-order terms, at this
time. If a non-standard set of drop rate coefficients are read from a probe's EEPROM and
subsequently used in the depth equation, this non-standard state is indicated in red in the
Launch Information window. 

5.5.8 Terminal Depth
Sippican probes are rated for specific depths. This rated depth will appear as the default
value in the Probe Selection dialog. 

Some users may be interested in modifying this depth. To modify the terminal depth for a
specific probe type, click the More button in the Probe Selection dialog to display the
Probe Attributes dialog for the selected probe.

The terminal depth can be decreased for purposes of saving time in the case of shallow
depth profiles. Alternatively, the terminal depth can be increased to maximize the amount
of data collected in the case of monitoring the probe beyond it's rated depth, until data
transmission is terminated by a wire break. In the event of monitoring the probe beyond
the rated depth, Sippican does not recommend increasing the terminal depth by more than
20%. Also, Sippican cautions that data collected when the wire is being stretched prior to
breaking is often suspect. Furthermore, termination of the data transmission by breaking
of the wire can cause the data collection program to appear to be hung up, particularly if
the terminal depth has been reset to be very deep relative to the rated depth. In this event,
terminate the data collection by selecting the Terminate menu item from the Actions
menu. All data collected until that time will be written to disk.



Additional Information Overview 5-53

MK-21/ISA  Bathythermograph Data Acquisition System

5.5.9 Navigation Input Reference - NMEA 0183
The NMEA 0183 Standard for Interfacing Marine Electronic Navigational Devices was
adopted by the National Marine Electronics Association (NMEA) to allow marine
instruments to transmit and receive information via a serial cable. This communication
between a single talker and multiple listeners is based on a block transmission. Blocks, or
groups of NMEA 0183 sentences, are transmitted over the serial cable. Each sentence has
a header that uniquely identifies the talker and the information contained in the sentence.
An external navigational device that supports the NMEA 0183 protocol continuously
transmits at least the minimum implementation of sentences. A serial cable connects the
external navigational device (talker) to a serial port of the WinMK21 control computer
(listener).

The WinMK21 application will accept NMEA 0183 navigational information on a serial
port. The WinMK21 application looks for the navigational information in the following
sentences:

RMC: Recommended Minimum Specific GPS/TRANSIT Data

RMA: Recommended Minimum Specific Loran-C Data

GGA: Global Positioning System Fix Data

GLL: Geographic Position - Latitude/Longitude

When any of the position-related NMEA sentences are received by WinMK21
application, the latitude and longitude information is displayed in the Launch Information
window. The position quality is appended to the latitude (SPS Mode, Differential GPS,
PPS Mode or "Fix not avail. or invalid").

Furthermore, the WinMK21 application allows you to reset the computer system clock
based on the external navigational device time provided by the ZDA, Time & Date
sentence. The time-related ZDA sentence must be selected in the Navigation Input
Parameters dialog.
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5.6 MK21 Interface Board Port Address
The factory default port address of the MK21 interface board is 0C00. The MK21
interface board communicates with the WinMK21 software by using up to 32 consecutive
I/O locations starting at the designated port address.

It is recommended to initially use the factory default settings on the MK21 interface
board. The MK21 interface board is designed to not interfere with other operations of your
computer, and in most cases the default settings will be the preferred settings. 

Depending on the installed MK21 interface board, the port settings can be changed, as
described in the following pages, using one of the following means:

• Setting a DIP switch

• Cutting one or more of seven installed blue jumpers

• Cutting a blue jumper, a red jumper, or both

5.6.1 Determine Available Port Address for Use by
MK21 Interface Board

The Device Manager system tool will allow you to determine which I/O port address
locations are available on the PC for use by the MK21 interface board. An I/O port base
address is indicated by a 4-digit hexadecimal number, such as 0C00. The MK21 interface
board has a number of requirements when selecting a valid port address as follows:

For the 4-digit hexadecimal port address WXYZ:

1. W may be any value from 0 to F

2. X must be either 4 or C.

For example, 1400 and 0C00 are valid; however, 1200 and 0D00 are invalid.

3. Y must be even.

For example, 1480 and 0C20 are valid; however, 1410 and 0CD0 are invalid.

4. Z must be zero.

For example, 1480 and 0C20 are valid; however, 1482 and 0C2C are invalid.

NOTE  The WinMK21 application and MK21 device drivers do not
automatically detect the port address of the MK21 interface board. The port
address settings for the WinMK21 application and MK21 device drivers must be

set to match the physical address. Thus, if it is necessary to change the port address of the
MK21 interface board it is very important to change both the physical address and the
port address settings used by either the WinMK21 application or the MK21 device driver
to locate the MK21 interface board. The physical address is changed using a DIP switch
or jumpers on the MK21 interface board.



MK21 Interface Board Port Address 5-55

MK-21/ISA  Bathythermograph Data Acquisition System

5.6.2 Changing the Port Address Settings in the WinMK21 
Application or MK21 Device Driver

For the MK-21/USB configuration, the port address is modified from the System
Parameters dialog. However, for the ISA configuration, the port address is maintained by
the MK21 device driver. In Windows NT a separate utility, SetMK21, is provided to
modify the port address setting for the device driver. In Windows 2000/XP, the port
address is modified using the Device Manager. 

5.6.3 Changing the Port Address Settings on the MK21 Interface 
Board—DIP Switch Configuration

On some MK21 interface boards, the port address is set using an 8-position DIP switch
(S1). The 8-position DIP switch is located in the middle lower section of the MK21
interface board. Each individual switch, as indicated by the number along the bottom, is a
toggle switch which can be either On or Off. A switch is considered On when the tab is in
the position closest to the On label. The switch is considered Off when the tab is in the
position away from the On label. In the figure below, switch 4 is in the Off position. All of
the other switches are in the On position.
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Setting the 8-position DIP switch using the 4-digit port address, WXYZ, is a three part
process as follows:

1. Set the DIP positions 1 - 3 based on the Y value of the port address as follows:

2. Set the DIP position 4 based on the X value of the port address as follows:

3. Set the DIP positions 5 - 8 based on the W value of the port address as follows:

Y 1 2 3
0 On On On *** Default - 0C00 (Y = 0)
2 Off On On

4 On Off On

6 Off Off On

8 On On Off

A Off On Off

C On Off Off

E Off Off Off

X 4
4 On *** Default - 0C00 (X = C)
C Off

W 5 6 7 8
0 On On On On *** Default - 0C00 (W = 0)
1 Off On On On

2 On Off On On

3 Off Off On On

4 On On Off On

5 Off On Off On

6 On Off Off On

7 Off Off Off On

8 On On On Off

9 Off On On Off

A On Off On Off

B Off Off On Off

C On On Off Off

D Off On Off Off

E On Off Off Off

F Off Off Off Off
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5.6.4 Sample Port Address Settings
The following samples illustrate the conversion from the 4-digit hexadecimal port address
to the 8-position DIP switch.

5.6.5 Changing the Port Address Settings on the MK21 Interface 
Board—Blue Jumper Configuration

For some MK21 interface boards, instead of a DIP switch, the port address is set with blue
jumpers. There are eight jumper locations, and they are positioned together in the middle
lower section of the MK21 interface board at S1. The presence of a jumper indicates an
On condition; the absence of a jumper indicates an Off condition. In the figure below, the

Port Address 1 2 3 4 5 6 7 8
0400 On On On On On On On On

0C00 On On On Off On On On On ***Default
0C60 Off Off On Off On On On On

1400 On On On On Off On On On

4CE0 Off Off Off Off On On Off On

ADDRESS = 0C00
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fourth jumper from the left is absent for an Off condition. All of the other jumper positions
contain a jumper and therefore are in the On condition. This configuration setting is the
default port address of 0C00. To change the setting, cut the jumper or jumpers in
accordance with the instructions provided for the DIP switch settings in “Changing the
Port Address Settings on the MK21 Interface Board—DIP Switch Configuration” on page
5-55. Any setting with an X = C can be selected. Settings with X = 4 cannot be selected.

5.6.6 Changing the Port Address Settings on the MK21 Interface
Board—Blue, Red and Buss Wire Jumper Configuration

For some MK21 interface boards, instead of a DIP switch, the port address is set with
blue, red and buss wire jumpers. These jumpers are positioned together in the middle
lower section of the MK21 interface board at S1. In the figure below, where none of the
jumpers is cut, the configuration setting is the default port address of 0C00. To change the
setting, cut the blue jumper, the red jumper, or both, for a port address of 4C00, 8C00, or
CC00, respectively. The buss wires should not be cut.

ADDRESS = 0C00

Buss wire

Buss wire

Blue jumper

Red jumper

ADDRESS = 4C00, cut the blue jumper
ADDRESS = 8C00, cut the red jumper
ADDRESS = CC00, cut the blue and red jumper
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SECTION 6
SERIAL-BINARY DATA TRANSMISSION

DESCRIPTION

he WinMK21 Data Acquisition and Post-Processing Software can transmit
temperature and sound velocity data either in Data Acquisition mode at the end of
a probe’s descent or in Post Processing mode using the serial-binary data

transmission interface. This section specifies the interface requirements for WinMK21
and an external serial device to achieve the serial-binary data transmission between them.

6.1 Physical Requirements
WinMK21 provides a transmit-only serial channel that conforms to either the TIA/
EIA-232 or the TIA/EIA-422 standard. WinMK21 does not support any software or
hardware flow control mechanism. In relation to WinMK21, the serial interface acts as an
asynchronous, simplex (TRANSMIT only) interface. 

The serial channel configuration parameters are as follows:

Parameter Setting

Baud Rate 2400

Character Bits 8

Stop Bits 2

Parity Odd

6.2 Protocol Requirements
WinMK21 transmits a four-byte header message to inform the host system of the probe
type selected by the operator. From this information, the host system can allocate the
proper amount of buffer space receiving the data as well as select the appropriate data
processing algorithm. The first data message is sent approximately two seconds after the
header message. WinMK21 sends a precise number of data messages for each of the probe
types as follows:

T
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Probe Type Total Number of Data Messages

T-4, T-6 750

T-5 3000

T-7 1250

T-10 330

XSV-01 1395

XSV-02 3281

A data message is sent for every two-foot depth interval. WinMK21 samples the probe
data at a constant 100 millisecond interval for the duration of the probe drop. Thus, the
time-based data is interpolated to generate the two-foot interval data.

6.3 Message Requirements

6.3.1 XBT Header Message Format
The four-byte header message transmitted for the XBT probes contains three bytes of all
zeroes and a fourth byte of five zeroes and a three bit probe type code. The header
message is transmitted only once and cannot be re-transmitted. The four-byte header
message, listed from MSB to LSB, is formatted as follows:

7 6 5 4 3 2 1 0
Byte 1 0 0 0 0 0 0 0 0

Byte 2 0 0 0 0 0 0 0 0

Byte 3 0 0 0 0 0 0 0 0

Byte 4 0 0 0 0 0 P2 P1 P0

1 0 0 T-4, T-6

1 0 1 T-5

1 1 1 T-7

0 1 0 T-10
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6.3.2 XSV Header Message Format
The four-byte header message transmitted for the XSV probes contains three bytes of all
ones and a fourth byte of five zeroes and a three bit probe type code. The header message
is transmitted only once and cannot be re-transmitted. The four-byte header message,
listed from MSB to LSB, is formatted as follows:

6.3.3 Data Message Format
The bit format of the data message is not standard and requires the receiving computer to
do bit manipulation and scaling to generate useful values. The data message consists of
four bytes containing a twelve-bit temperature/sound velocity word and a twelve-bit depth
word. The four-byte data message, from MSB to LSB, is formatted as follows:

The bits X11–X0 contain the temperature/sound velocity word. The bits Y11–Y0 contain
the depth word. Bit 0 (LSB) of byte 1 is always set to a one while bit 0 of bytes 2–4 are
always set to zero. This feature can be used to properly frame a data message should
individual bytes be lost. Bit 1 of byte 4 (P) provides an odd parity check of the entire data
message.

6.3.4 Data Out-of-Range Messages
When the input stimulus to WinMK21 exceeds the expected range, it loads default values
into the data message. The temperature/sound velocity portion of the data message (X11–
X0) is set to all zeroes if the data is less than the lowest expected value. The temperature/
sound velocity portion of the data message (X11–X0) is set to all ones if the data is greater
than the highest expected value. In all cases, the depth data reflects the actual depth of the
measurement.

7 6 5 4 3 2 1 0
Byte 1 1 1 1 1 1 1 1 1

Byte 2 1 1 1 1 1 1 1 1

Byte 3 1 1 1 1 1 1 1 1

Byte 4 0 0 0 0 0 P2 P1 P0

0 1 1 XSV-01

1 1 0 XSV-02

7 6 5 4 3 2 1 0
Byte 1 X11 X10 X9 X8 X7 X6 X5 1

Byte 2 X4 X3 X2 X1 X0 1 1 0

Byte 3 Y11 Y10 Y9 Y8 Y7 Y6 Y5 0

Byte 4 Y4 Y3 Y2 Y1 Y0 0 P 0
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6.3.5 Temperature Range
The valid temperature range of WinMK21 is 26°F to 98°F. If the input stimulus measures
less than 26°F, the temperature bits are set to all zeroes in the data message. If the input
stimulus measures greater than 98°F, the temperature bits are set to all ones in the data
message.

6.3.6 Sound Velocity Range
The valid sound velocity range of WinMK21 is 4610 ft/sec to 5118 ft/sec. If the input
stimulus measures less than 4610 ft/sec, the sound velocity bits are set to all zeroes in the
data message. If the input stimulus measures greater than 5118 ft/sec, the sound velocity
bits are set to all ones in the data message.

6.3.7 Processing Algorithm
When the host receives an XBT header message, bits X11–X0 of the data message contain
temperature data. The host converts this twelve-bit word to temperature in degrees
Fahrenheit with the following equation:

Temperature [°F]= X / 4095 * 72 + 26

When the host receives an XSV header message, bits X11–X0 of the data message contain
sound velocity data. The host converts this twelve-bit word to sound velocity in feet/
second with the following equation:

Sound Velocity [ft/sec]= X / 4095 * 508 + 4610

Irrespective of the header message, bits Y11–Y0 of the data message contain depth data.
The host converts this twelve-bit word to depth in feet with the following equation:

Depth [ft]= Y * 2
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